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1 GENERAL INFORMATION

Read through this operating manual carefully before use and become familiar with the product.
Installation and start-up should not be carried out before reading and understanding this
document. Keep this manual readily available so that you can reference it as needed.

1.1 What Is the Purpose of this Operating Manual?

This manual serves as an aid for the installation and operation of the product and supports the
technical staff with all operating and maintenance tasks to be performed. Furthermore, this
manual is aimed at preventing dangers to life and health of the user and third parties.

1.2 Who Is this Operating Manual Targeted to?

The operating manual provides a code of conduct for personnel tasked with the set-up,
operation, maintenance, and repair of gas engines. A certain level of technical knowledge with
respect to the operation of gas engines and basic knowledge of electronic ignition systems are
necessary. Persons who are only authorized to operate the gas engine shall be trained by the
operating company and shall be expressly instructed concerning potential hazards.

1.3 Which Symbols Are Used in the Operating Manual?

The following symbols are used in this manual and must be observed:

Example

This symbol indicates examples, which point out necessary handling steps
and techniques. In addition, you receive additional information from the

T T examples, which will increase your knowledge.

® Notice
This symbol indicates important notices for the user. Follow these. In
addition, this symbol is used for overviews that give you a summary of the

TEFICE necessary work steps.

Warning

This symbol indicates warnings for possible risks of property damage or
risks to health. Read these warning notices carefully and take the
mentioned precautionary measures.
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1 GENERAL INFORMATION

Danger

This symbol indicates warnings for danger to life, especially due to high
voltage. Read these warning notices carefully and take the mentioned

precautionary measures.

1.4 Which Abbreviations/Acronyms Are Used in the Operating Manual?
In the manual or the user interface, the following abbreviations / acronyms are used.

Abb.
ADV

ASC

ASO

ATDC
BTDC

CAN bus

CE

CPU

°crankshaft

CSA

DC

Term Description

Advance Advanced with
respect to top dead
center

Automatic Spark

Control

Auxiliary Auxiliary

Synchronization Synchronization

Output Output

After top dead center

Before top dead
center

Bus for control
devices / networks

Controller Area
Network Bus

Conformité
Européenne

Conformity with EU
directives

Central Processing
Unit

Central processing
unit

Degree crankshaft

Canadian Standards
Association

Direct Current Direct Current

Explanation

Indicates the direction for
timing

Automatic spark control

Output for synchronizing the
MIC4 and other controllers

Asynchronous serial
connection system for linking
control units

Mark based on EU legislation
for certain products in
conjunction with product safety

Unit for the rotation angle of
the crankshaft

Organization that defines
standards, inspects products
for safety compliance, and
issues pertinent certifications.
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Abb.

DetCon

EMI

EMC

GPI

GPO

HV

ISO

LED

MiC

MICT

MOSFET

TDC
PG

POT

PWR
RET

Rev. 01/2016

Term

Detonation Control
System

Electromagnetic
Interference

Electromagnetic
Compatibility

General purpose input Multi-purpose input

General Purpose
Output

High voltage

International
Organization for
Standardization

Light Emitting Diode

MOTORTECH Ignition
Controller

MOTORTECH
Integrated
Configuration Tool

Metal Oxide
Semiconductor Field-
Effect Transistor

Top dead center

Panzergewinde

Potentiometer

Power
Retard

Description

Detonation control
system

Electromagnetic
interference

General Purpose
Output
High voltage

International
Organization for
Standardization

Explanation

Serves to prevent major engine
damage that can be caused by
knocking combustion.

Compatibility of electrical or
electronic equipment items
with their surroundings

Light emitting diode Light emitting electronic semi-

MOTORTECH
ignition controller

Metal Oxide
Semiconductor
Field-Effect
Transistor

Panzer Screw
Thread

Output / current

Retarded with
respect to the top
dead center

conductor

Software for the configuration
of the MIC4

Semiconductor component

Screw thread type for cable
screw connections

Continuously adjustable
potential divider

Indicates the direction for
timing



1 GENERAL INFORMATION

Abb.

RS485/
TIA485

USB

Term Description
Recommended

Standard 485/

Telecommunications

Industry Association

485

Universal Serial Bus

Explanation

Industrial standard for a
physical interface for
asynchronous serial data
transfer

Serial connection system to
link a computer to external
devices

Rev. 01/2016



2 SAFETY INSTRUCTIONS

2.1 General Safety Instructions
The following safety instructions must be followed in the area in which the device is operated:

High voltage! Danger to life!

While the engine is running, the area around the ignition system poses a
particular risk of danger due to high voltage. The following parts should
therefore not be touched or removed unless explicitly stated otherwise:

DANGER

- Ignition coils and caps

- Wires of the high voltage circuit

- In- and output wiring of the ignition controller

- Pickups and their wiring

Danger to persons with pacemakers!

Electromagnetic impulses in the wiring of the ignition system may exceed

the permissible limits of pacemakers. Persons with pacemakers must
TR therefore not be present in the vicinity of the ignition system being

operated. Mark the operating location of the ignition system with the
corresponding standardized warning symbol.

MOTORTECH equipment is manufactured as state of the art and therefore safe and reliable to
operate. Nevertheless the equipment can cause risks or damage can occur, if the following
instructions are not complied with:

— The gas engine must only be operated by trained and authorized personnel.

— Operate the equipment only within the parameters specified in the technical data.
— Usethe equipment correctly and for its intended use only.

— Never apply force.

— Forallwork such as installation, conversion, adaptation, maintenance, and repair, all
equipment must be disconnected from the mains and secured against unintentional
reactivation.

— Perform only such maintenance and repair work as is described in this operating manual,
and follow the instructions given while working. For maintenance of the equipment, only use
spare parts supplied by MOTORTECH. Further work must only be performed by personnel
authorized by MOTORTECH. Non-compliance with the instructions will void any warranties
for the proper function of the equipment as well as the responsibility for the validity of the
certifications.

— Safety devices must not be dismounted or disabled.

- Avoid all activities that can impair the function of the equipment.

Rev. 01/2016 u



2 SAFETY INSTRUCTIONS

— Operate the equipment only while it is in proper condition.
- Investigate all changes detected while operating the gas engine or ignition system.

- Ensure compliance with all laws, directives and regulations applicable to the operation of
your system, including such not expressly stated herein.

- Ifthe gas-carrying parts of the system are not entirely tight, gas may escape and result in an
explosion hazard. Upon completion of all assembly works, always check the system's
tightness.

- Always ensure adequate ventilation of the engine compartment.

— Ensure a safe position at the gas engine.

2.2 Electrostatic Discharge Hazards

Electronic equipment is sensitive to static electricity. To protect these components from damage
caused by static electricity, special precautions must be taken to minimize or prevent
electrostatic discharge.

Observe these safety precautions while you work with the equipment or in its vicinity.

- Before performing maintenance or repair work, ensure that the static electricity inherent to
your body is discharged.

- Do not wear clothing made from synthetic materials to prevent static electricity from
building up. Your clothing should therefore be made of cotton or cotton mix materials.

— Keep plastics such as vinyl and Styrofoam materials as far away as possible from the control
system, the modules, and the work environment.

— Do not remove the circuit boards from the housing of the device.

2.3 Information on Electric Isolation
If ground and earth potential are not properly isolated, the following problems as well as others
can occur:

- Electromagnetic interferences (e.g. ground loops)

- Signal corruption (e.g. of the analog voltage signal)

- Unwanted leakage currents

Therefore, earth potential and the negative pole of the power supply of all devices in the electric
assembly that provide the option, should be connected separately. If possible, the negative pole

of the power supply should only be connected to earth potential at one point in the entire
system.
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Wiring Example

Device with Device featuring
shielded wires protection class Il
5]

ny
g

=

L+
24V DC
- 1
® Occurrence of ground loops
The devices shown in the following image do not feature the possibility to
connect the earth potential and the negative pole of the power supply
TEFICE separated from each other. How ground loops are created.

A ground loop is a ground connection of an electric wiring assembly that is
closed as a loop. Due to impedance (resistance R » 0) of the loop, low-
frequency interference currents can lead to an unwanted voltage drop in the

signal path.
Device 1 Device 2
II R II
|

! !

Ground loop
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2 SAFETY INSTRUCTIONS

2.4 Special Safety Instructions for the Device

Danger to life! Hazardous residual voltage!

After stopping the ignition, there is dangerous residual voltage for up to
three minutes in the ignition system. Do not touch any components of the
ignition kit during this time.

Explosion hazard!

Never remove the service screw or the service cover, unless the system is
located in a non-explosive environment.

Explosion hazard!

The replacement of parts or assemblies can impair compliance with CSA
Class |, Division 2 (Group C, D), T4.

Explosion hazard!

When the system is powered up, do not remove any connectors unless the
system is not located in a potentially explosive atmosphere.

Explosion hazard!

Never remove the equipment while the device is connected to a power
source unless the system is not located in an explosive environment.

Explosion hazard!

Do not remove or replace the fuse while the equipment is live.
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Risk of burning!

The surfaces of the system may heat up to high temperatures.

Operational safety!

All connector screws and screw joints must be adequately tightened. Refer
to the section Mechanical Data on page 22.

After the service cover on the device (Light Duty and Heavy Duty Version)
has been opened, e.g. to complete the wiring, it must be refitted so that it is
in the same alignment as it was prior to opening. The USB connection is
then again behind the service screw. If the mounting is rotated, maintaining
the indicated protection classes, as well as compliance with CSA-Class |,
Division 2 (Group C, D) is impaired.

Risk of destruction!

Magnetic fields and heat occur when welding, which may damage or
destroy the MIC4. Therefore, pay attention to the following when welding:
- Disconnect all electrical connections to the MIC4 prior to welding.

— Protect the MIC4 against direct contact with the welding unit and
magnetic fields, sparks and liquid metal.

2.5 Proper Disposal

After the expiration of its service life, MOTORTECH equipment can be disposed of with other
commercial waste, or it may be returned to MOTORTECH. We will ensure its environmentally
friendly disposal.

Rev. 01/2016 15



3 INTENDED USE

3.1 Functional Description
The devices of the MIC4 series are microprocessor controlled ignition systems, that are
comprised of one 32 bit main processor (CPU) and an output board.

Please note that the manufacturer is not required to implement configurations of the ignition
controller for specific engines, and that devices may be delivered without pertinent
configuration.

The ignition controllers of the MIC4 series use information supplied by the pickups to precisely
determine the correct timing for the respective outputs. The timing is influenced by various
inputs made either automatically or manually. This can be implemented with manual
potentiometers, the analog input signals, a speed characteristic, or with a serial interface (USB,
CAN bus, RS485).

During operation, the ignition controllers continuously monitor the system status of all installed
pickups and the correct operation of the primary ignition circuit by checking the information
received.

Depending on the severity of an error that is detected, the device will shut down immediately or
warn the operator. A corresponding message can be viewed on a connected PC.

To protect the engine, the ignition controllers additionally have an adjustable overspeed shut-
off.

3.2 Applications
The ignition controllers of the MIC4 series are designed for specific 2- or 4-stroke gas engines.
From 1 to max. 16 ignition outputs are available.

The ignition controllers supply the energy required for the corresponding ignition coils of the
gas engines and can supply signals for peripheral equipment.

Any use other than the one described in the operating manual shall be considered improper use
and will result in the voiding of all warranties.
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4 PRODUCT DESCRIPTION

4.1 Technical Data

4.1.1 Certifications
The ignition controllers of the MIC4 series are certified as per the following
directives/regulations:

CSA
The Light Duty Version and the Heavy Duty Version fulfill the following directives:

— Class|, Division 2, Group C and D; T4
CSA Std C22.2 No. o0 -10

— CSAStd C22.2 No. 142-M1987 (R 2004)
— CSAStd C22.2 No. 213-M1987 (R 2004)
— ANSI/ISA 12.12.01, Ed 1 (2007)

— UL Std No. 916, Ed 3 (1998)

The Panel Mount Version fulfils the directives if it is installed in a correspondingly certified
panel.

CE
— EMC Directive
— Limits as per DIN EN 55011:2011
— Emission standard for industrial environments as per DIN EN 61000-6-4:2007

— Immunity for industrial environments as per DIN EN 61000-6-2:2006

— Low Voltage Directive

— DINEN 60947-1:2007 — Low voltage switchgear, Part 1: General definitions

Rev. 01/2016 17



4 PRODUCT DESCRIPTION

| C‘\ st

Certificate of Compliance

Certificate: 2165361 (LR 211392) Master Contract: 211392

Project: 2511645 Date Issued; September 20, 2012
Issued to: Motortech GmbH

Hogrevestrasse 21-23
Celle, 29223

Germany

Attention: Rainer Voelz

The products listed below are eligible to bear the CSA
Mark shown with adjacent indicators 'C" and 'US’ for

Canada and US or with adjacent indicator 'US' for
US only or without either indicator for Canada only.

sp@; Marin Banu
Issued by: Marin Banu, P Eng.
C us

PRODUCTS

CLASS 2258 02 - PROCESS CONTROL EQUIPMENT - For Hazardous Locations

CLASS 2258 82 - PROCESS CONTROL EQUIPMENT - For Hazardous Locations -
Certified to US Standards

Class |, Div. 2, Groups C and D; T4

+ MIC850 Series of Motortech Ignition Controller, input ratings: 18 to 30Vdc., 8.0 A max.; output 390 V max.;
Ambient temperature range -20°C to +60°C (with display) or -40°C to +70°C (without display).

Note: The USB, SD Card-Slot and JTAG connectors are only to be used in areas known to be non-hazardous.

* MIC950 Series of Motortech Ignition Controller, input ratings: 24V DC nomina (18 to 32V)., 15.0 A max.;
output 250 V max.; Ambient temperalure range - to +65°C. Type 4 Endl. |P65.

Note: The USB, SD Card-Slot and JTAG connectors are only to be used in areas known to be non-hazardous.

« MIC4 Series of Motortech Ignition Controller, input ratings: 24V DC nomina (10 to 32V)., 7.0 A max.;

output 250 V max.; Ambient temperature range -40°C to +50°C (Panel Mount Version), -40°C to +60°C
(Light Duty Version), -40°C to +70°C (Heavy Duty Version).

DQD 507 Rev. 2012-05-22 Pager 1
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@)=

Certificate: 2165361 (LR 211392) Master Contract: 211392

Project: 2511645 Date Issued: September 20, 2012

APPLICABLE REQUIREMENTS
CSA Std C22.2 No. 0-10 - General Requirements — Canadian Electrica Code — Part 11
CSA Std C22.2 No. 142-M 1987 (R 2004) - Process Control Equipment

CSA Std C22.2 No. 213-M1987 (R 2004) - Non-Incendive Electrical Equipment for Usein Class |, Division 2
Hazardous Locations

ANSI/ISA 12.12.01, Ed 1 (2007) - Nonincendive Electrical Equipment for Usein Class |

and I, Division 2 and Class 11, Division 1 and 2 Hazardous
(Classified) Locations

UL Std No. 916, Ed 3 (1998) - Energy Management Equipment

MARKINGS

- CSA Monogram with “C” and “US" indicators

- Company name

- Model name or number

- Serial number or Date of manufacturing

- Electrical Ratings

- Hazardous Location Designation: Class |, Division 2, Groups C and D; T4
- Temperature Code

- Maximum Ambient Temperature

- Warning re. substitution of components (included in the Manua )
- Caution re. do not disconnect

DQD 507 Rev. 2012-05-22 Page: 2
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4 PRODUCT DESCRIPTION

CSA
Group

Certificate: 2165361 (LR 211392) Master Contract: 211392

Project: 70012922 Date Issued: October 17, 2014

- Warning re. Substitution of components (included in the Manual)
- Text: “EXPLOSION HAZARD! Do not disconneet while circuit is live unless area is known to be non-
hazardous.”

Note - Jurisdictions in Canada may require these markings (o also be provided in French language. It is the
responsibility of the manufacturer to provide bilingual marking, where applicable, in accordance with the
reguirements of the Provincial Regulatory Authorities. 1t is the responsibility of the manufacturer 1o determine
this requirement and have bilingual wording added 1o the "Markings".

DO 507 Rev. 2012-05-22 Page: 3
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EC DECLARATION OF CONFORMITY

The company:

declares that the products:

intended purpose:

MOTORTECH GmbH
Hogrevestrasse 21-23
29223 Celle

Ignition controller

use with gas Otto engines

complies with the provisions of the following EC Directives:

under consideration of the following standards:

The marking of the product is:

This declaration is submitted by:

Name: Florian Virchow

Celle, 2012-04-19

Place, date

Rev. 01/2016

EMC Directive 2004/108/EC
(Group 1, Class A)

Low-voltage directive 2006/95/EC
Application on gas engines

DIN EN 55011:2011

DIN EN 61000-6-2:2006
DIN EN 61000-6-4:2007
DIN EN 60947-1:2007

P/N 66.00.40x-Xx
P/N 66.00.41x-xx
P/N 66.00.44x-xx

Position in company: Managing Director

GuD—

Legally binding signature
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4 PRODUCT DESCRIPTION

4.1.2 Mechanical Data
The MIC4 has the following mechanical characteristics.

Dimensions Panel Mount Version:
282.1mm x 202 mm x 66.6 mm (11.11" x 7.95" x 2.62")
(length x width x height)

Light Duty Version:
304 MM X 240 mm x 95.5 mm (11.97" X 9.45" x 3.76")
(length x width x height)
Heavy Duty Version:
304 MM X 240 mm X 115,5 mm (11.97" X 9.45" X 4.39")
(length x width x height)
Weight Panel Mount Version:
5.2 kg (11.5 lbs)
Light Duty Version:
3.9 kg (8.5 lbs)

Heavy Duty Version:

6.7 kg (14.8 lbs)
Shape of device See chapter Overview Drawings on page 30.
Mechanical environmental The housing is resistant to general atmospheric
conditions contaminations.

Resistant to gas engine lubricants.

Panel Mount Version:
Protection class: 1
Protection: IP20

Light Duty Version:
Protection class: 1
Protection: IP54

Heavy Duty Version:
Protection class: 1
Protection: IP65

The specified protection classes and types are only
guaranteed if the following tightening torques are
maintained:

- All Mg bolts: 0.8 Nm to 1 Nm (0.6 lb-ft to 0,7 lb-ft)
- PG screw joints: 4.5 Nm to 5 Nm (3.3 b-ft to 3.6 lb-ft)
- Service screw: 2.5 Nm to 3 Nm (1.9 lb-ft to 2,2 lb-ft)
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Feature Value

Standard single seal inserts for Suitable for a cable with a diameter of 6 mm to 13 mm.
PG screw joints (Heavy Duty
and Light Duty Version)

Multiple seal inserts for PG Suitable for up to three cables, each with a diameter of
screw joints (Heavy Duty and 6 mmto7 mm.

Light Duty Version)

Climatic environmental Panel Mount Version:

conditions -20 °C to +50 °C (-4 °F to +122 °F)

Light Duty Version:

-40 °C to +60 °C (-40 °F to +140 °F)
Heavy Duty Version*:

-40 °C to +70 °C (-40 °F to +158 °F)

max. 85 % humidity without condensation
up to 2000 m (6561.68') above sea level

Determining maximum ambient temperature for Heavy Duty Version
* The maximum ambient temperature for the Heavy Duty Version of the MIC4 is dependent on the
net power delivered. This can be up to 80 °C (176 °F) for low net power.

Net power Max. ambient temperature

18 W 80 °C (176 °F)
36 W 75 °C (167 °F)
54 W 70 °C (158 °F)

Determine the maximum ambient temperature for the Heavy Duty Version of the MIC4 as follows:

1. Determine the net power (P) delivered.

Engine type Max. ambient temperature

Two-stroke engine

_ Number of Revolutions [min™*] x Energy [J] x Number of Ignition Outputs
60

Four-stroke engine

_ Number of Revolutions [min™*] x Energy [J]  Number of ignition outputs
&0 2

Notice: Energy refers to the set energy limit (see Timing — Schedule A/B — Energy on
page 106). The number of outputs refers to the configured outputs.
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4 PRODUCT DESCRIPTION

2. Calculate the maximum ambient temperature.

max. ambient temperature in°C=80-(P-18) x5 /18

The formula is defined for P 2 18 W. The ambient temperature is therefore limited to

80 °C (176 °F).

4.1.3 Warning Notices on the Device

Warning notice on the device

WARNING! Read and understand the
installation and operating manual prior to
installing or making any adjustments.

EXPLOSION HAZARD! Do not disconnect
while circuit is live unless area is known to
be non-hazardous. For wiring details please
refer to the operating manual.

CAUTION! Do not pressure wash this ignition
module. Damage to electronic components
may result.

24

Validity of warning notices on device

The warning notices on the devices are valid for MIC4 and all CSA-certified
components from MOTORTECH connected to it.

French translation

ATTENTION! Avant d’installer ou d’effectuer
une modification, lisez et comprenez le
manuel d’utilisation et d’installation.

RISQUE D‘EXPLOSION! Ne débranchez pas
lorsque le circuit est sous tension sauf si la
zone est connue pour étre non dangereuse.
Pour plus de détails de cablage, veuillez
consulter le manuel d”utilisation.

ATTENTION ! Ne pas laver cette boite de
contréle en utilisant un jet sous pression. Les
composants électriques peuvent étre
endommagés.

Rev. 01/2016
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4.1.4 Product Identification — Labeling on the Device
The necessary numbers for unique product identification are on the device:

—  Product number of the ignition controller (P/N)
— Arrangement number of the ignition controller (A/N)

— Serial number of the ignition controller (S/N)

= MOTORTECH

www.motortech.de

| P/N 66.00.410-16 |

c € |A/N  422.16.C000-000-AA-0 |

[S/N 01008066 |
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4 PRODUCT DESCRIPTION

4.1.5 Electrical Data
The MIC4 has the following electrical characteristics.

Feature Value

Power consumption Max. 100 W at 24 V

Power supply 10V DCto32VDC
(nominal voltage: 24 V DC)

Required current Max. current 7 A. An estimation of the power requirements can be
found after this table.

Number of outputs 8 or 16 outputs

Firing angle The size of the firing angle depends on the max. overspeed. The

smallest firing angle per output bank can be calculated using the
following formula:

Overspeed [min*]

x360° x 1.7 ms
60

Ignition Angle =
Ignition frequency With full energy output (all 16 ignition outputs with 300 mJ), an
ignition frequency of 250 Hz as continuous load is possible. With
less ignition energy or in case of a brief overload, 333 Hz is
possible. The maximum output load of 75 W must not be
exceeded.

Overspeed [min™?!]

Ignition Frequency; sprore = o0

X Number of Ignition Outputs

Overspeed [min™']

1
Ignition Frequency, spoke = E X 50

x Number of Ignition Qutputs

Output connector 17-pin military connector

Estimation of Current Requirements
These current values are based on a nominal speed of 1800 rpm and 300 mJ energy.

Outputs Voltage Required current  Voltage Required current
8 24V 2.3A 12 V ** 4.6 A

12 24V 3.3A 12V ** 6.4 A

16 24V 4.3A 12V ** 6.8A*

* Ignition energy is limited to 250 m].
** Nominal voltage 24 V DC
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Electrical Data for Inputs and Outputs
The inputs and outputs of the ignition controller have the following electrical data:

Inputs and outputs
Analog current input
Analog voltage input

Aux. analog input supply
voltage

Digital input (Start/Stop)

Digital input (schedule A/B)

Digital input (GPI, multi-
function input)

Go/NoGo and GPO outputs

Signal LED
ASO output

Rev. 01/2016

Values

Working resistance 27 Q, damping 1 pF
Working resistance 12.4 Q, damping 200 nF

5Vto 24V /50 mA depending on the configuration in the
MICT

Wiring
Input current: max. 20 mA

Ignition stop: o V to 0.8 V (low level)
Ignition release: 2.8 V to 32 V (high level)

Wiring
Input current: max. 20 mA

Schedule A: 0 Vto 0.8 V (low level)
Schedule B: 2.8 V to 32 V (high level)

Wiring
Input current: max. 20 mA

Low level: o Vto 0.8V
High level: 2.8 Vto 32V

(Function dependent on the configuration in MICT, see
Inputs/Outputs — Inputs on page 112)

One GPO (General Purpose Output) and one Go/NoGo output
Implementation as optical MOSFET

Voltage applied: 7V DC to 32 V DC max.

Peak/steady current: 100 mA DC max.

Output power: 2.5 max.

Internal resistance: 58 Q to 60 Q

Activation delay: 0.5 ms / 100 mA load max.

Deactivation delay: 0.2 ms / 100 mA load max.

If a short is found at the output, a safety circuit, which makes
the output highly resistive, is found at the output, so that the
current sets itself at 50 mA to 60 mA.

Six LEDs are used as status indicators.

TTL level (5 V)
max. current: £ 10 mA
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4 PRODUCT DESCRIPTION

Inputs and outputs Values

Pickup input Impedance: 10 kQ

The voltage supply for active pickup can be set using the
MICT from 5 Vto 24 V.

Max. frequency for the pickups: 10 kHz

The formula for determining the frequency of the pickups can
be found in the note following this table.

For a pickup output impedance of 120 Q to 10 kQ, the pickups
connected to the MIC4 may not have a higher voltage than
+40 V peak-peak and the connected power may not exceed

1 Watt.

Ignition coil outputs Output voltage: 250 V max.
Output energy in normal operation mode: 300 m) max.

Output energy in the start phase: 500 m) max.

® Frequency of the pickups
. The frequency of the pickup is calculated as per the following formula.
Overspeed [min™1] ) .
NOTICE Frequency = T X Number of Pickup Event per Revolution

4.1.6 Interfaces
Depending on the device version, the following interfaces are available:

USB Interface
— Compatible with USB 1.1 and higher

- The Connector Bversion is only suitable for temporary data exchange and not for a
permanent connection.

- Max. wire length 5 m (16.4")

CAN Bus 2.0B Interface
- AsperlSO 11898 standard, 50 kBit/s to 1 MBit/s

- Protected against transients (automotive classification)
- Max. 110 participants

- Max. wire length 250 m (820") depending on the transfer rate

28 Rev. 01/2016



RS485 Interface
According to TIA-485-A (03/2003)

Max. 32 participants
Max. data transfer rate 9.6 kBit/s to 115.2 kBit/s

Max. wire length 100 m (328') depending on the transfer rate

® Pay attention to the wiring diagrams
Depending on the device version, certain signals or interfaces described in
these instructions may not be available. You are also always to pay

attention to the wiring diagrams enclosed with the input and output cable

NOTICE
harnesses.

4.1.7 Requirements for External Equipment
External equipment shall fulfill the input and output specifications of the MIC4.
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4 PRODUCT DESCRIPTION

4.1.8 Overview Drawings

Panel Mount Version
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Light Duty Version
The connectors shown correspond to the standard version.
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Heavy Duty Version
The connectors shown correspond to the standard version.
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4.1.9 LEDs and Connections

LEDs on the MIC4

O Status

(O Firing

(O Pickup 1

O Pickup 2

(O Pickup 3

O apPoO
s

Status LED flashes green when the device is running with no errors. If an error

occurs, the LED is red, for a warning it is yellow.

Firing LED lights up when the ignition is active.

Pickup1to3 Flashing LEDs indicate activity of the pickups.

GPO LED is on when the GPO is activated.

Connections and Functions under the Service Cover

' ~
Power  USB Pickup
rawa|

A®1234537a 0 112
CAN B@® Digital Output

2345867
Analog/Digital Input
Wl -

123456 1234567891011
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Labeling Function

o o Power Connection for the supply voltage (see Input Wiring — Power
3 3 o Supply on page 40)
a =
o 2 % USB USB connection for connecting to the PC
A v
o S g’- PB Button acknowledges errors, warnings and alarms or triggers a
2 as R X
o @ reset of the ignition controller. Please refer also to the notice
% %’_ below.
A/B Potentiometer for the manual adjustment of the ignition timing.
The setting only has an effect if the potentiometer in the MICT is
activated.
Pickup Connection for the pickups (see Input Wiring — Pickups on page
41)
CAN CAN interface for connecting external equipment (see Output
Wiring — CAN Bus Interface on page 51)
Digital Output Connection for digital outputs (refer to Output Wiring — Digital
Outputs (Go/NoGo, GPO, ASO) on page 47)
RS485 RS485 interface for connecting external equipment (see Output
Wiring — RS485 Interface on page 52)
Analog/Digital Input Connection for timing & safety devices (see Input Wiring — Timing

and Safety Devices on page 44)

Behavior of the button PB
With the PB button on the device you can perform the following actions:

— Press briefly (< 3 5):
Existing warnings are acknowledged.

— Presslongerthan3s:
If no pickup signals are detected and an operating error exists, this will
be acknowledged together with all alarms. Warnings are acknowledged
in any case, even if no operating error exists.

— Press longer than 15 s:
If no pickup signals are detected, the ignition controller restarts.
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5 INSTALLATION INSTRUCTIONS

5.1 Unpacking

Unpack the equipment, taking care not to damage it, and ensure that the operating manual is
always stored with the ignition controller and is easily accessible. Check the contents for
completeness and verify that the device type meets your application requirements.

Scope of Supply
The scope of supply of the MIC4 ignition controller consists of the following components:

— Ignition controller of the MIC4 series

— Installation set incl. four vibration dampers

— Ground strap

— Three multiple sealing inserts and five sealing plugs for PG screw joints

— Storage device (USB flash drive or CD-ROM) with software for configuring the ignition
controller

— USB interface cable for connecting the ignition controller to a PC/laptop

— Operating manual

5.2 Installation of the Ignition Controller

The installation of the MIC4 ignition controller is implemented on a fixed bracket, e. g. on a wall
near the engine, for the Light Duty or Heavy Duty Version. Install the Panel Mount Version in a
suitable panel. Use the included vibration dampers and the ground strap for all three versions.
The installation location of the controller must be selected so that the distance to the pickups
installed on the engine ensures a reliable signal transmission to the ignition controller, and so
that there is adequate space for maintenance and repair work. The mechanical specifications
must always be complied with (refer to Mechanical Data on page 22). The ground strap serves to
ground the ignition controller and must be used accordingly. Ensure a flawless electrical
connection for this purpose.

Installation locations where strong vibrations or extreme ambient temperatures are present are
not permissible and result in the warranty being voided. The permissible temperature ranges
are:
— Panel Mount Version: -20 °C (-4 °F) to +50 °C (+122 °F)
— Light Duty Version: -40 °C (-40 °F) to +60 °C (+140 °F)
- Heavy Duty Version: -40 °C (-40 °F) to +70 °C (+158 °F)

To ensure sufficient cooling through the cooling body, the Heavy Duty Version must be

mounted so that the vanes of the cooling body are vertical and the hot air can escape
upwards unimpeded.
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5 INSTALLATION INSTRUCTIONS

Risk of destruction!

The device must not be installed directly on or at the engine, as vibration
and heat may cause damage to electronic components.

Installation of the MIC4
There are two options for using the vibration dampers from the MIC4's scope of supply. The hole
patterns can be found in section Overview Drawings on page 30 .

Option A
1. Fasten the four vibration dampers Bl to the
@ )] 27 Nm /19 b-ft selected installation location. Use four
$ screws M8x16 B, four rim lock washers
/ m8 Bl and four washers ms L.

2. Fasten the MIC4 to the vibration dampers.
Use four washers M8 B and four poly lock
nuts Mg B,

» Fasten the ground strap to the ground
pin (see below).

1
o
1

\

== 0
$

£D 3 27 Nm /19 Ib-f
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2 27 N 19 -1

4
ol 27 Nm /19 |b-ft

Installation of the Ground Strap
(/% 11 Nm / 8 Ib-ft

D

Rev. 01/2016

Fasten the four vibration dampers B tothe
MIC4. Use four screws M8x16 . four rim
lock washers M8 Bl and four washers

ms L.

Fasten the MIC4 to the selected installation
location using the vibration dampers. Use
four washers M8 B and four poly lock nuts
M8

» Fasten the ground strap to the ground
pin (see below).

Fasten the ground strap El o the MIC4
ground pin. To do so, use one washer
Mé , one tooth lock washer A6 E#l and
one poly lock nut M6 n

Connect the ground strap to one of the
sides suitable for grounding.

> You can wire the ignition controller as
described in section Wiring of the
Device on page 39.

37



5 INSTALLATION INSTRUCTIONS

5.3 Determine the Installation Location of the Pickup
Set the positions of the pickups depending on engine type and application. All angle reference
information is based on:

TDC 1st cylinder / compression cycle

The installation location for the pickups must have adequate mechanical strength and must not
exceed the specified temperature ranges. The pickups are designed for the appropriate use
only, multiple use of the pickup signal is not permissible. Ensure good accessibility to facilitate
the calibration of the sensor. Comply with the pertinent regulations for the wire routing.

For the exact positioning of the individual pickups, refer to the examples given in the drawings
(see section Input Wiring — Pickups on page 41).
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6 WIRING OF THE DEVICE

6.1 Input and Output Wiring on the Controller

NOTICE

Rev. 01/2016

Operational safety!

All connector screws and screw joints must be adequately tightened. Refer
to the section Mechanical Data on page 22.

After the service cover on the device (Light Duty and Heavy Duty Version)
has been opened, e.g. to complete the wiring, it must be refitted so that it is
in the same alignment as it was prior to opening. The USB connection is
then again behind the service screw. If the mounting is rotated, maintaining
the indicated protection classes, as well as compliance with CSA-Class |,
Division 2 (Group C, D) is impaired.

Operational safety!

Improper wiring using the PG screw joints impairs the compliance with the
specified protection classes as well as with CSA Class I, Division 2 (Group C,
D). Please adhere to the following points:

- Do not pass any cables without matching sealing inserts through the PG
screw joints.

- Asealinginsert must be used in every PG screw joint.

— Unused bore holes for the sealing inserts must be sealed using sealing
plugs.

— The PG screw joints must be adequately tightened.

For additional information on PG screw joints and sealing inserts please
refer to Mechanical Data on page 22.

Assignment of the wire colors

Take the assignment of the wire colors of the wiring harness for the input
and output wiring from the wiring plan enclosed with the wiring harness.

Pay attention to the wiring diagrams

Depending on the device version, certain signals or interfaces described in
these instructions may not be available. You are also always to pay
attention to the wiring diagrams enclosed with the input and output cable
harnesses.

39



6 WIRING OF THE DEVICE

6.1.1 Input Wiring — Power Supply

Variations

1 Battery Generator Control Unit
— o |-
J— 2 Power supply
—0 L+
[OO)] SR e My
- +
10-32VDC
3 Battery Charger
~v
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MOTORTECH

6.1.2 Input Wiring — Pickups

Example Configuration (one Active, two Passive Pickups)

j - Camshaft

Crankshaft

j ‘! O (Reset)

Crankshaft

{
|\

[
Y

PU1 Pawer 6
PU1 Signal @
PUt Com (=)
Pt Shield |(=).
PU2 Power @
PU2 Signal @
©)

e |(=)

PU3 Power @
PU3 Signal @

PU2 Com
PU2 Shield

The recommended distance to the triggering is 0.75 mm to 1 mm (0.03" to 0.04") for MOTORTECH
pickups. Please note that additional fine-tuning is required for every pickup position due to the

different conditions of the engines.
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6 WIRING OF THE DEVICE

One revolution of the pickup changes the distance as follows:

Thread Change in distance

M12x1 1revolution 2 1 mm (0.04")
5/8"-18 UNF 1 revolution 2 1.41 mm (0.05")
3/4"-16 UNF 1 revolution 2 1.59 mm (0.06')

Allocation of the Wire Colors (Example Configuration)

Camshaft
PIN Designation Wire color
1 PU1 Power brown
2 PU1 Signal black
3 PU1 Com blue
4 PU1 Shield shield
Crankshaft (Reset)
PIN Designation Wire color
6 PU2 Signal Flywheel with PIN Flywheel with hole
white brown
7 PU2 COM Flywheel with PIN Flywheel with hole
brown white
8 PU2 Shield shield
Crankshaft
PIN Designation Wire color
10 PU3 Signal white
11 PU3 Com brown
12 PU3 Shield shield

For problems with the pickup signal, refer to the section Pickup Input Errors on page 165.
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Adjusting the pickup sensitivity

Depending on the type of impulse source (interference), it may be necessary
to increase the pickup sensitivity to ensure that the resultant signal
strength is sufficient for reliable operation. You can make these
adjustments in the MICT. Refer to the section Engine — Pickups on page 98.

Aux. Pickup Supply Voltage

An auxiliary supply voltage for active pickups can be configured using the
MICT. The voltage can be set in the range from 5 to 24 V and is supplied at
the connections PU1 Power to PU3 Power. Refer to the section Engine —
Pickups on page 98.
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6 WIRING OF THE DEVICE

6.1.3 Input Wiring — Timing and Safety Devices

The input wiring of the timing and safety equipment is dependent upon the hardware version of
the ignition controller. These are found in the MICT in the view Runtime Data — Information (refer
to section Runtime Data — Information on page 143).

Wiring Hardware Version 1.3.x/1.4.x (Example Configuration)

E *) See subsequent drawings for details

x = bridge for permanent authorization
*) (must be removed for external ignition
authorization)

Switch Start/Stop
————+— ] open Ignition — OFF

closed Ignition — ON

L
|

N
Y

Switch A/B
open Schedule A
I(D@@@@@@@@l closed Schedule B
£t 2 £ <L 8 232 =
> 2% "848 z°356
= £ g2 = 2 5
oz g 83 ©
@

44 Rev. 01/2016



Wiring Hardware Version 1.2.x (Example Configuration)

*) See subsequent drawings for details

—

*)

x = bridge for permanent authorization
(must be removed for external ignition
authorization)

Switch Start/Stop

N
Y

A
_|

-

Mo
Analog GND @
Analog PWR @

tin- (=)
i+ [()
Analog Shield @
Start'Stop In @
Earth °

Schedule A/B In @

shied [(2)

I

Two-Wire Transmitter

Loop Power

+1In

-1n
1

@ Shield

______ L Sensor GND
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et |(2)

open Ignition — OFF
closed Ignition — ON
Switch A/B

open Schedule A
closed Schedule B

Four-Wire Transmitter

-lin
Shield

/\ Loop Power
+V
+1 4H +1In
) \_
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6 WIRING OF THE DEVICE

EXAMPLE

Aucxiliary supply voltage of analog inputs

An auxiliary supply voltage for the analog inputs can be configured using
the MICT. The voltage can be set in the range of 5 to 24 V and is made
available on the connection Analog PWR. If using current transmitters,
Analog PWR is used for Loop PWR and Analog GND is used for Sensor GND.
Please refer to the section Timing — Analog Inputs on page 102.

Wiring MICq4 ignition controller and DetCon detonation control system

The following diagram shows an example of the wiring of a MIC4 ignition
controller with a DetCon detonation control system in cases where the

analog current signal (4-20 mA) is to be used for the ignition timing
adjustment.

° Schedule A/B In

ignition
I@ ?_(?_? @ @ @ @ @l controller
IOOOOOOOOOOOO] petcon
+ SRR - T+ detonation
g E § § g Dg = 23 E JT_ @ ; control system
8§ § 2 &8 =88 &2 £ B

Furthermore, the limits of the analog current input will need to be set at
4 mA to 20 mA and the auxiliary supply voltage of the analog inputs to 24 V
in the MICT. Please refer to the section Timing — Analog Inputs on page 102.

The timing is transmitted by MIC4 via the auxiliary synchronization output
(ASO) to the DetCon, and will need to be wired and configured accordingly.

Please refer to the section Output Wiring — Digital Outputs (Go/NoGo, GPO,
ASO) on page 47.
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@ General Purpose Input GPI

The general purpose input GPI can be assigned various functions via the
configuration. Refer to the section Inputs/Outputs — Inputs on page 112.

NOTICE

6.1.4 Output Wiring — Digital Outputs (Go/NoGo, GPO, ASO)

Example Configuration

[Ki |-
*) DetCon or other external device (for

E(Z I--- wiring of the DetCon, see following

example)

K1 = Go/NoGo relay
K2 = GPO relay
L27to32VDC

Go/NoGo High 6
Go/NoGo Low @
GPO High |(-2)
6P Low [(+)
As0 out |(e)
ASOGND [(=)
Shield @
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6 WIRING OF THE DEVICE

I I
L+
+
Relay L
——
Al l
-*— 1 A2
- ( Relay
A2 —te—
High  Low
=] g l
High  Low

(L27to32VDQ)

DetCon connection

Connect the ASO output on the DetCon to the connections Timing 1 and
Timing 2 on connector Ignition Pulse.

EXAMPLE
DetCon
Ignition Pulse
~ o~
= =

Y

[DOOOOO®O]
£ = £ = 5 o =
323832

w
8 ¢ 2 & a g
2 2 © @ <
s 8
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MOTORTECH

6.1.5 Wiring — PowerView3

Connect the PowerView3 visualization unit to the MIC4 as follows.

CAN Connection between Ignition Controller and PowerView3

As shown in the following illustration, you can connect the PowerViews directly to the
MOTORTECH ignition controller using the CAN cable delivered with the PowerViews. To do so,
you need to insert the connector in the CAN interface on the PowerViews. On the ignition
controller, connect the color-coded conductors of the CAN cable to the correct CAN interface
connections.

Connector for CAN
interface on PowerViews

CAN1_H3

Shield
CAN1_Term 5
CAN1_LA4
CAN1_Term 2
GND 1

F
i

W

white
green
brown

| CAN interface on the
ignition controller

Display High [(=)
Display GND|(N)
Display Low @

Shield |(+)
High |©@)A
GND |(=)
Low @

Shield |(2)

I

N
o
(]
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6 WIRING OF THE DEVICE

PowerViews Power Supply via the Ignition Controller

If you use a MOTORTECH ignition controller with a service cover and connector strip, you have
the option of supplying power to the PowerViews3 via the ignition controller. A special connector
is included in the PowerView3's scope of supply. This must be replaced for the connector for the
power supply from the ignition controller's scope of supply.

Connector supplied with Connector supplied with
the ignition controller PowerViews *

* A cable is already attached to this connector, the other end of which is connected to the
PowerViews.

a (IO
@

1. Disconnect the ignition controller's power supply.
2. Remove the connector for the power supply from the ignition controller.

3. Positive terminal: Disconnect the conductor from the contact B and insert it into the
contact Bl of the connector included with the PowerViews.

4. Negative terminal: Disconnect the conductor from the contact B and insert it into the
contact B of the connector included with the PowerViews.

5. Connect the device's power supply.

» The PowerViews is now supplied with power via the connector on the ignition controller.
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6.1.6 Output Wiring — CAN Bus Interface

The product must be connected to a CAN bus as follows:

First device Second-to-last device
CAN Bus
c 0O = c 0 =
5 2 z £56 85 £63
= o
T O o

R=120Q // R=120 Q

q
A\ Ij
OOOOEEOE N\
_% ;‘ E‘ w w
Second device Last device

Notice: The CAN-Bus connectors 1-4 are currently unavailable.

® CANopen protocol
If you require information on the CANopen protocol, please contact your
MOTORTECH contact person.

NOTICE

CAN bus wiring
Note the following when connecting the CAN bus:

— A maximum of 110 devices can be connected to a CAN bus.

- The maximum wire length is 250 m (820'") depending on the transfer
rate.

- Each bus end must be fitted with a terminating resistor of 120 Q (see
drawing).
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6 WIRING OF THE DEVICE

6.1.7 Output Wiring — RS485 Interface

The RS485 interface can be wired as two-wire or four-wire wiring and twisted cables must be
used. With both variants the load resistance (Rr=120 Q) is the characteristic impedance of the
cable.

Two-Wire Wiring

First device Last device

Second device Second-to-last device
Four-Wire Wiring
First device Last device
(Master) (Slave)

Second device Second-to-last
(Slave) device
(Slave)
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Connection on the Ignition Controller

Tx High
Tx Low
Rx High
Rx Low

GND

]

O]
=}

[}
5

Tx Low |(=)

GND |(=)
Rx High [(=)
Rx Low |(=)

® Wiring of the RS485 interface
Follow these instructions for the RS485 interface wiring:
. - Max. 32 devices can be connected to a bus.
NOTIGE - The maximum wire length is 100 m (328') depending on the transfer
rate.

- Each bus end must be fitted with a terminating resistor with 120 Q (as
indicated in the drawing).
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6 WIRING OF THE DEVICE

6.2 Ignition Coil Wiring

Protection when using wiring rails

Every wiring rail on the engine block should be grounded to avoid
disruptions in the device caused by secondary current in the ignition coils.

Ignition Coil Wiring

In the MICT there are two types of wiring with predefined output
configuration supported in the engine database for many engines:

NOTICE — Wired in straight order
— Wired in firing order
For information on straight order wiring refer to Straight Order Wiring of the
Ignition Outputs on page 57 and Engine — Parameters on page 90.

For wiring in firing order, the first cylinder in the firing order is connected to
the A1 output, the second to B1 (A2 for one output board), etc.

If a different wiring was implemented, the output configuration in the MICT
must be adapted accordingly. Please note that the wiring cannot be
checked by the software (see section Engine — Parameters on page 90).
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6.2.1 17-Pole Connector — Standard
The table contains the pole assignment for the Light Duty and Heavy Duty MIC4 for 8 and 16

cylinders.

(View: 17-pole connector from the outside)

m 16 outputs 8 outputs |

I o6 Mmoo N W >

—_

- »n ™ TV = =z =

Rev. 01/2016

Output A1
Output B1
Output A2
Output B2
Output A3
Output B3
Output A4
Output B4
Output As
Output Bg
Output A6
Output B6
Output A7
Output B7
Output A8
Output B8

Ground

Output A1
Output A2
Output A3
Output A4
Output Ag
Output A6
Output A7
Output A8
not assigned
not assigned
not assigned
not assigned
not assigned
not assigned
not assigned
not assigned

Ground
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6 WIRING OF THE DEVICE

6.2.2 10- and 9-Pole Connectors (Panel Mount Version)
The tables show the pole assignments for the Panel Mount Version with a 10-pole and a 9-pole
connector:

Connector A Connector B

OOOOOEOEROE| [DOOOEOOOOE)

Pin Assignment Connector A

Pole 16 Outputs /8 Outputs
1 Output A1

2 Output A2

3 Output A3
4 Output A4
5 Output Ag
6 Output A6
7

8

9

Output A7
Output A8
Ground

10 Ground

Pole Assignment Connector B (not available for 8 outputs)

Pole 16 outputs

1 Output B1
2 Output B2
3 Output B3
4 Output B4
5 Output Bs
6 Output B6
7 Output B7
8 Output B8
9

Ground
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6.3 Straight Order Wiring of the Ignition Outputs

Risk of damage to engine

If you use straight order wiring, it is absolutely necessary that the
MOTORTECH wiring rail for the respective engine is used and correctly
installed. Even a rotated installation can cause serious damage to the
engine, for example.

Straight order wiring, along with wiring in firing order, is supported by the MICT for many
engines with predefined output configurations in the engine database. That means that if the
wiring is carried out accordingly and the option wired in straight order (user defined orientation)
is selected in the MICT, no other adaptation of the output configuration is necessary.

You can use straight order wiring, if:

Wiring takes place via a corresponding MOTORTECH wiring harness and a MOTORTECH
wiring rail. The harness is marked with the following information: PLEASE NOTE! The firing
order needs to be configured directly in the ignition controller. The ignition coils on the
wiring rail are identified with Connector Pin 1 to Connector Pin X.

Make the wiring of the ignition controller corresponding to the instructions in the following
sections (for example with an open wiring harness or via a junction box).

Execution of straight order wiring is dependent on the following factors:

Output connector on the ignition controller (17-pole connector [Light Duty/Heavy Duty
Version], 10-pole/9-pole connector [Panel Mount Version])

One or two output banks in the ignition controller (8 or 16 outputs)
Type of engine (in-line or V engine)

Alignment of the wiring rail(s)
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6 WIRING OF THE DEVICE

6.3.1 Straight Order Wiring for the Panel Mount Version

Panel Mount Version with 8 Outputs (One Output Bank)
Connector A

OOOOOOOOO®

Wiring Connector A (Connector B not used with 8 outputs)

8 outputs In-line engine V engine
(one output bank)
1 Output A1 S1Sp1 S1Sp1
2 Output A2 S1Sp2 S2Sp1
3 Output A3 S1Sp3 S1Sp2
4 Output A4 S1Sp4 S2Sp2
5 Output Asg S1Sps S1Sp3
6 Output A6 S1Spé6 S2Sp3
7 Output A7 S1Sp7 S1Sp 4
8 Output A8 S1Sp 8 S2Spy4
9 Ground
10 Ground

S = connector on the wiring rail
Sp = ignition coil with the corresponding number on the wiring rail
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Panel Mount Version with 16 Outputs (Two Output Banks)

Connector A

Connector B

OOOOOOOEOE| POOOEOOOOE)

Wiring Connector A

Pole

N

O 00 N o U p»~ W

16 outputs
(two output banks)

Output A1
Output A2
Output A3
Output A4
Output As
Output A6
Output A7
Output A8
Ground

Ground

Wiring Connector B

Pole

N

O 00 N o v p~ W

S = connector on the wiring rail
Sp = ignition coil with the corresponding number on the wiring rail

Rev. 01/2016

16 outputs
(two output banks)

Output B1
Output B2
Output B3
Output B4
Output Bg
Output B6
Output B7
Output B8

Ground

In-line engine

S1Sp1
S1Sp3
S1Sps
S1Sp7
S1Spog
S1Sp11
S1Sp13
S1Sp 15

In-line engine

S1Sp2
S1Sp4
S1Sp 6
S1Sp 8
S1Sp 10
S1Sp 12
S1Sp 1y
S1Sp 16

V engine

S1Sp1
S1Sp2
S1Sp3
S1Sp 4
S1Sps
S1Sp6
S1Sp7
S1Sp 8

V engine

S2Sp1
S2Sp2
S2Sp3
S2Spy
S2Sps
S2Sp6
S2Sp7
S2Sp8
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6 WIRING OF THE DEVICE

6.3.2 Straight Order Wiring for Light Duty and Heavy Duty Version

Light Duty and Heavy Duty Version with 8 Outputs (One Output Bank)

(View: 17-pole connector from the outside)

Pole 8 outputs In-line engine V engine
(one output bank)

A Output A1 S1Sp1 S1Sp1

B Output A2 S1Sp2 S2Sp1

C Output A3 S1Sp3 S1Sp 2

D Output A4 S1Sp 4 S2Sp2

E Output Ag S1Sps S1Sp3

F Output A6 S1Sp 6 S2Sp3

G Output A7 S1Sp7 S1Sp 4

H Output A8 S1Sp 8 S2Sp4

J =

K -

L =

M -

N =

P -

R -

S -

T Ground

S = connector on the wiring rail
Sp = ignition coil with the corresponding number on the wiring rail
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Light Duty and Heavy Duty Version with 16 Outputs (Two Output Banks)

(View: 17-pole connector from the outside)

Pole 16 outputs In-line engine
(two output banks)
A Output A1 S1Sp1
B Output B1 S1Sp2
C Output A2 S1Sp3
D Output B2 S1Sp4
E Output A3 S1Sps
F Output B3 S1Sp 6
G Output A4 S1Sp7y
H Output B4 S1Sp 8
J Output As S1Spog
K Output Bg S1Sp 10
L Output A6 S1Sp 11
M Output B6 S1Sp12
N Output A7 S1Sp13
P Output By S1Sp 14
R Output A8 S1Sp 15
S Output B8 S1Sp16
T Ground

S = connector on the wiring rail
Sp = ignition coil with the corresponding number on the wiring rail
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V engine

S1Sp1
S2Sp1
S1Sp 2
S2Sp2
S1Sp3
S2Sp3
S1Sp 4
S2Spy4
S1Sps
S2Sps
S1Sp 6
S2Sp6
S1Sp7y
S2Sp7y
S1Sp 8
S2Sp8



7 FUNCTIONS

The ignition controllers of the MIC4 series include freely configurable safety and auxiliary
functions that, amongst others, can shut down the engine in case of fault.

Angle indications in the operating manual

All angles in this operating manual are given in °crankshaft. Exceptions are
clearly identified.

7.1 Pickup Sensitivity

To increase the signal interference distance, the sensitivity of the pickup signal inputs can be
changed for suitable pickup signals. This setting can be implemented individually for each
input. For this purpose, a pre-trigger voltage can be set below which signals are interpreted as
interference and are therefore not analyzed. A pre-trigger voltage set to a high level will thus
result in a low pickup sensitivity level.

You can enter the settings for the pickup sensitivity with the MICT. Refer to the section Engine —
Pickups on page 98.

7.2 Monitoring of Pickup Signals

The MIC4 monitors the pickup signals. Any other errors are displayed in the MICT. For more
information on the errors, please refer to the overview in the section entitled Pickup Input Errors
on page 165.

7.3 Go/NoGo

The MosFET output (Go/NoGo) is a potential-free output. It is closed during firing and opens
when the ignition switches off. The max. switching current is 100 mA. The output can drive an
external relay that e.g. opens a gas valve.

The following errors can cause the ignition outputs to shut down:
- Overspeed

- Pickup error

-  Error HV power supply

— Failure of the output monitoring

- Overload/temperature shut-down

- Alarms

- Insufficient supply voltage (Low Power)
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7.4 Timing Correction
The ignition controller has several functions for the timing correction.

Influences on ignition timing

Be aware that the actual timing of the engine can also be influenced by
external signals (e.g., analog current or voltage input).

Operational safety!

The MIC4 ignition controller must first be correctly configured for the engine
being used before you can start the engine.

An incorrect configuration can result in damage to the engine.

The figure below gives you an overview of the different functions of the timing correction, which
will be explained in more detail in the subsequent sections. Functions that can be activated/
disabled via the MICT are marked by a switch symbol.
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7 FUNCTIONS

Per schedule:

| Base Timing

ISpeed Curve l—/—}@
| Analog Voltage Input |—/—P
| Analog Current Input |—/—}
| Potentiometer I—/—P

Global:

| Ignition Timing Correction I—b@

Per cylinder:

Cylinder Individual [ i0oy by the —»®

Offset min./max. cylinder
individual offset

Limited by the
min./max. ignition
timing
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7.4.1 Manual Timing Correction

The ignition controllers of the MIC4 series include two permanently installed overwind-protected
potentiometers for manually correcting the ignition timing. The max. range is defined with the
corresponding limits that are set by the user. Potentiometer A adjusts the ignition timing of
schedule A and potentiometer B adjusts the igniting timing of schedule B.

7.4.2 Analog Inputs

The timing point control can be adjusted with a linear current signal. This signal can be
supplied, for example, by a potentiometer, a pressure sensor for charging pressure, or a
detonation controller.

With the analog process signal (current loop signal) at the analog current input, the timing point
can be offset in the advanced or retarded direction within a defined range.

Similarly or additionally, the timing can also be influenced by an analog voltage signal at the
corresponding input.

The levels of the analog inputs can be set in the range from o to 20 mA and o to 10 V. You can
make this configuration with the MICT. Please refer to the section Timing — Analog Inputs on
page 102.

At the voltage output (Analog PWR), a configurable auxiliary voltage is supplied that can be used
for supplying power to external sensors.
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Configuration examples

In this example the analog inputs are configured in the Timing — Analog
Inputs window as follows:

EXAMPLE — Input current: 4-20 mA

— Input voltage: o-5 V

Characteristic 4-20 mA / 0-5 V — ignition timing adjustment towards retard

BTDC
A
409 T 4mA oV
30° — o
Base Timing 30° BTDC
15° retarded ignition
15° I8
20mA 5V
50
o° =y

Characteristic 4-20 mA / 0-5 V — ignition timing adjustment toward
advanced.

BTDC
A
40° 7 20mA 5V

O —t
30 15° advanced ignition

Base Timing 15° BTDC
4mA oV
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7.4.3 Cylinder-to-Cylinder Alignment
The cylinder-to-cylinder alignment enables the user to change the timing for individual cylinders
to optimize their combustion.

You can enter the settings for the cylinder-to-cylinder alignment with the MICT. Please refer to
the chapter Cylinder Individual Offsets on page 151.

Use of measuring unit

Use this setup option only if a suitable measuring unit is available for
determining the optimum timing point, so that the result of a change can be
assessed immediately.

7.4.4 Speed Curve

To optimize the ignition, for example, during the start phase of the engine, a speed curve can be
defined for the MIC4 ignition controllers. To create this curve, up to eight adjustable speed
points are available.

You can configure the speed curve with the MICT. Refer to the section Timing — Schedule A/B —
General on page 104.

7.4.5 Ignition Timing Correction

There are two options for making corrections to the ignition timing:

— CANopen/Modbus/J1939
The field buses can be used to adjust the cylinder individual ignition timing points in 0.1°
increments by max. +/- 12.5° crankshaft, restricted by the ignition timing point limits of the
current schedule.

— MICTvia USB
Please refer to the section Runtime Adjustments — Timing on page 147.

7.5 Firing Angle
The min. distance between two ignition angles depends on the overspeed. The smallest ignition
spacing per output bank can be calculated using the following formula:

Overspeed [min*]

o
%0 % 360° x 1.7 ms

Ignition Angle =

7.6 HV-Power Supply Error Monitoring
The voltage applied is monitored for excess voltage or low voltage by the integrated power
supply. For both errors a Power-Fail error is saved and the device shuts off.
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7.7 Output Monitoring

On the output board of the MICg4 ignition controller there are electronic switches used. If one of
these switches is defective, this would lead to a primary short or a primary open output, which
can cause damage to the engine. To avoid engine damage, the MIC4 ignition controllers are
therefore fitted with an integrated monitoring feature, which shuts down the ignition if a
problem is detected.

7.8 Schedules A/B
The MIC4 ignition controllers offer two separate schedules for the parameterization of the
ignition timing and energy.

By closing input Schedule A/B, the listed parameter settings for schedule B can be selected. A
possible application for this is e.g. operation with different gases. If only one schedule is
configured, this is used regardless of the switch position.

You can configure the schedules with the MICT. Please refer to Timing — Schedule A/B — General
on page 104 and Timing — Schedule A/B - Energy on page 106.

Operational safety!

If you use schedules A and B, the advanced timing point should be linked to
schedule B (switch closure). If a wire ruptures, schedule A is automatically
selected with the retarded (and thus safer) timing point.

7.9 Alarms

The MIC4 ignition controllers include 16 freely configurable alarms in total. These alarms can be
freely allocated to the general purpose output (GPO) and set depending on the following
functions:

- Limit for speed exceeded/not reached

- Limit for engine operating hours exceeded/not reached

- Limit for spark plug operating hours exceeded/not reached
— Warning active

- Error active

- Limit for temperature exceeded/not reached

- Limit for supply voltage exceeded/not reached

- Limit for global ignition timing exceeded/not reached

- Limit on the analog voltage input exceeded/not reached

- Limit on the analog current input exceeded/not reached

- Limit of the minimum spark duration exceeded/not reached
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—  Misfire rate (primary, single output) over limit

- Misfire rate (primary, all outputs) over limit

- Misfires per second (primary, all outputs) above threshold

— Consecutive misfires (primary, single output) above threshold

- Misfire rate (secondary, individual output) above threshold

- Misfire rate (secondary, all outputs) above threshold

— Misfires per second (secondary, all outputs) above threshold

- Consecutive misfires (secondary, single output) above threshold

A hysteresis can be defined for some alarms. You can configure the alarms with the MICT. Refer
to the section Inputs/Outputs — Alarms on page 108.

7.10 GPO: General Purpose Output
The function of the general purpose output (GPO) can be set as desired as normally closed or
normally open. The GPO can be used for the freely definable alarms.

You can enter the settings for the general purpose output with the MICT. Refer to the section
Inputs/Outputs — Alarms on page 108.

7.11 ASO: Auxiliary Synchronization Output

The ASO is an output of the MIC4 for synchronizing the MIC4 ignition controller and a connected
control unit. The possible applications include detonation control, valve control, and fuel
injection control.

The ASO signal is low-active, i.e. the pulse width is defined as the time difference between the
raising and falling edge (pulse width = trising — traling). The raising edge of the signal marks the
configured engine rotation angle. With the variable pulse width, the values can be allocated to
the engine rotation angle. A max. of 16 pulses can be configured for this purpose.

The pulse width is known at the time of the active edge, as the falling edge of the signal
precedes the raising edge by the value of the pulse width. The controller calculates the duration
of the falling edge from high-level to low-level and then back to the starting value of the high-
level.

The ASO signal can be inverted via the configuration. It will then be high-active.

You can configure the auxiliary synchronization output with the MICT. Refer to the section
Inputs/Outputs — ASO1 (Auxiliary Synchronization Output) on page 110.
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70

EXAMPLE

Application of the ASO signal
The following example will illustrate the application of the ASO signal:
- Four-stroke engine with 6 cylinders

— Ignition angle 120° - 120°

Synchronization between MIC4 and Valve Controller

Ignition angle in ASO signal in Pulse duration in
°crankshaft °crankshaft us

1 0/720 718 160

2 120 118 80

3 240 238 80

4 360 358 80

5 480 478 80

6 600 598 80

Schematic Representation (Standard Settings)

Level

*) active edge

The valve controller should receive the active edge of the ASO signal before
the top dead center of a cylinder. The first pulse duration should be twice
as long and thus mark the beginning of a cycle. The ASO signal generated
by the MIC4 increases by 2° each time before the ignition signal from Low
to High, as can be seen in the schematic drawing. This edge is analyzed by
the valve controller as the active edge.

The ASO signal drops in accordance with the configured pulse duration
from High to Low before the active edge. The valve controller then has
already measured the pulse duration of the active edge and can provide
information on the allocation of the signal. In the example shown here, the
first cylinder is marked with a pulse width of 160 ps versus 80 ps for other
cylinders. If the valve controller measures a pulse width of 160 ps, the
subsequent signal is therefore allocated to the first cylinder. The next
signal then corresponds with the second cylinder in the ignition sequence,
etc.
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MOTORTECH

7.12 Ignition Energy
The ignition energy can be set separately for the start phase and normal operation. Here
different settings can be made for schedules A and B.

You can configure the ignition energy with the MICT. Please refer to the section Timing —
Schedule A/B - Energy on page 106.

7.13 Access Control
The MIC4 has four operating levels, three of which can be secured with different PINs. As a
default setting, the access control is not activated. If the access control for the MIC4 is activated,
itis independent from the access levels that control authorizations within the MICT.

Access control in the MICT and on MIC4

A user is logged in to the Advanced Service access level on the MICT. He
changes a configuration and would like to download the change to the

EXAMPLE

MICg4. Although he has the full authorization set in the MICT, he is prompted

to log in with the PIN for the Level 3 (Master) on the MIC4.

A variety of functions are at your disposal in the four operating levels of the MIC4 . The figure

below illustrates this:

Level o: Read Only

Runtime Data

All

Access Control

Login

Level 1: Operator

Level 2: Service

Runtime Adjustment

Level 3: Master

Runtime Adjustment

Timing
Energy

Commands

Commands

Reset Position

Configuration

Alarm Commands
Error Commands
Misfire Counters

Set Engine Hous
Set Spark Plug Hours

Timing

Cylinder Individual
Offsets

Download to Device

Access Control

Self Test

All
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Reset All PINs
Enable Access Control
Disable Access Control
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7 FUNCTIONS

The following functions are available on the different levels:

- Level o (Read Only)
Enables read-only access for all users.

- Level 1 (Operator)
The user can operate the Alarm Commands, Error Commands, and the Misfire Counter on
this level.

- Level 2 (Service)
Only the Service level has access to modifications of the runtime adjustments for Timing and
Energy and the commands Set Engine Hours, Set Spark Plug Hours. The Cylinder Individual
Offsets and the Settings for Self Test can also be executed in this operating level.

- Level 3 (Master)
On this level, the Master can, in addition to the other adjustments, modify the Reset Position
and Reset All PINs and Enable/Disable Access Control. This authorization is also needed to
transfer a configuration to an ignition controller.

For information on the access levels in the MICT, refer to the section Access Levels in the MICT on
page74.
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MICT is an abbreviation for MOTORTECH Ignition Configuration Tool. With the MICT, you can
configure your ignition controller, and you can view and adjust the operating data of your
engine. When working with the MICT, you can press the F1 key at any time to access context-
sensitive help.

8.1 MICT System Requirements

For the installation of the MICT, the following minimum requirements must be fulfilled:
— x86-compatible PC, at least performance class Intel Pentium 4 with 2 GHz

- 128 MB free RAM

— 200 MB free disk space

— USBinterface 1.1 or higher

— Display with minimum XGA resolution (1024 x 786 pixels)

- Microsoft Windows® XP, Windows® 7

8.2 MICT Installation

The software for the installation of the MICT is on the storage device (USB flash drive or CD-ROM)
provided with the ignition controller.

To install the MICT, proceed as follows:

1. Start the installation:

— Viathe menu:
Start the file Start.exe on the storage device. Start the installation routine of the MICT
via Software - Install MICT.

— Directly from the storage device:
Start the installation routine of the MICT directly. It is located in subdirectory
Installation on the storage device and for example named as follows: MICT-2.0.0-
setup.exe.

2. Runtheinstallation.
Follow the instructions of the installation routine. Note that the license agreement terms
must be accepted before using the MICT.

3. Install the USB driver via the menu as well or directly from the storage device.

— Viathe menu:
Software -> USB Drivers -» Install USB Drivers

— Directly from the storage device:
Start the exe file in subdirectory Drivers (e.g. CDM v2.10.00 WHQL Certified.exe).

» The MICT is set up. You can connect your PC to the ignition controller via the USB
interface.
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8.3 Access Levels in the MICT

You can open the MICT on your PC via Start -> Programs -> MOTORTECH -> MICT 2.0.0 -> MICT.
After opening the MICT, select the access level for which you have clearance. The access level
controls the options you have at your disposal in the MICT. The password required for access
can be obtained from your MOTORTECH contact person (refer to Customer Service Information on
page 166).

M Change Access Level ﬁ

Access Level

@ Read Only

) Customer

*) Service
Advanced Service

Password:

Coc J[ ol ]

The following access levels are available:

— Read Only
On this level, the user can open a configuration and transfer it to the device. However, he
cannot make changes to the configuration. The user has read-only access to all other
settings.

— Customer
This level enables the configuration of the basic functions required for operation in addition
to the read-only function.

- Service
This level contains all functions for a standard installation.

— Advanced Service
This level offers full access to all functions of the MICT and is enabled and accessible for
specially trained personnel only.

The following sections describe the options at your disposal with the Advanced Service access
level. If you have registered for a different level, you cannot execute all functions shown.
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8.4 Configuration Pages (Overview)
The configuration pages are divided into the following sections:

24 unnamed.micd (MIC4x1.08) - MICT (= | G e
n’—'f_ik Device _Settings _Document _Jools _Help

B  a-ds58s 1% a0me

Configuration Page o=
+ Engine Engine Selection Engine Information
] or Series Type [Hew Engne Confiaration) v
| Cylinder Names
. RIAX Engine Type: 4-stroke engne
Ignition Outputs Caterpillar
1 Ignition Coils Clark
B— — | Pickups Cooper Bessemer —-—n
4 Timing e
TS Guazcor
x Ingersoll Rand
@1|[EfiSchedule A Jembaches
| General Liebherr
7 Energy AN
4 () ScheduleB L
¥ Sequence
P Superior
| Energy Weukezha
| Miscellaneous.
4 Inputs/Outputs
| Alarms
1 AsOL
| Inputs
4 Miscellanecus
| Communication
| Information &
|
MOTORTECH does not labiity for the info n th database. Pleace contact MOTORTECH if discrepandies
are found.
If your engine i not avadable in the kst contact MOTORTECH service please.

@ COM3 IDMIC4x1.08 (1.5.1 [0000sB01]) ADV. SERVICE Full Access Version: 2.7.00000 —'—B

Item no. Area

1 | Menu bar

Toolbar

Navigation bar
Configuration section
Status bar

The functions in the menu bar, navigation bar and the toolbar as well as the configuration
section will be described in the following.
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The status bar provides you with the following information (from left to right):

— Status display
Indicates whether a connection is established with the device:

— Green: Connection established
— Red: The connection was interrupted and is being restored

— Gray: The connection is not established and is not being restored

— Indication of the interface being used for the connection to the device
— Indication of the device ID
— Indication of the access level of the user in the MICT

- Indication of the operating level for the MIC4 if access control has been activated and the
user has logged on with a PIN.

— Indication of the MICT program version

8.5 Menu Bar and Toolbar

The following functions are available to you via the symbols on the toolbar and the entries in the

menu bar:
Symbol Menu Function
N File -> New Creates a new configuration.
ql] File -> Open Opens an existing configuration.
File -> Save / Saves the current configuration.
E File -» Save As
File -> Recent Documents The last five configuration files used are
offered for selection.
File -> Close Closes the current configuration.
File -> Open trace Opens a runtime data record (trace file). Refer
to the section Runtime Data on page 116.
File -> Open pickup trace Opens a saved record of pickup signals
(putrace file). Refer to the section Pickup Trace
on page 81.
@) File -> Change Access Level Changes the MICT access level for accessing
K the configuration data and functions.
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Menu

File -» Print

File -»> Print To PDF File

File -»> Print Preview

File -» Quit

Device -» Connect

Device -» Disconnect

Device -» Download to device

Device-»> Upload from device

Device -» Runtime data

Device -» Log

Device -» Runtime adjustments

Device -» Cylinder individual
offsets

Device -» Self test

Function

Prints the current configuration.

Prints the configuration to a PDF file.

Opens a print preview of the configuration.
Exits the MICT.

Connects to the device.

Cuts the connection to the device.

Downloads configuration data from the PC to
the device. Refer to Working with
Configurations on page 86.

Uploads configuration data from the device to
the PC. Refer to Working with Configurations
on page 86.

Opens the window Runtime Data. Refer to the
section Runtime Data on page 116.

Opens the window Log (Advanced Service
only). Refer to the section Log on page 144.

Opens the window Runtime Adjustments
(Service and Advanced Service only). Please
refer to the section Runtime Adjustments on
page 145.

Opens the window Cylinder Individual Offsets
(Advanced Service only). Please refer to the
chapter Cylinder Individual Offsets on page
151.

Opens the window Self Test (Service and
Advanced Service only). For this read section
Self Test on page 80.
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Symbol

78

Menu

Device -» Pickup trace

Device-» Set spark plug operating
hours

Device -» Set engine operating
hours

Device -» Set date and time

Device -» Send command - Reset
misfire counters

Device -» Send command -»
Acknowledge operational error

Device -» Access Control

Device -» Temperature Extremes

Settings -> Language

Settings -» Online update settings

Settings-» Database settings

Settings -» Temperature scale

Settings -» Display by cylinders

Function

Loads the automatically recorded pickup
signals from the device. Refer to the section
Pickup Trace on page 81.

Opens the window Set spark plug operating
hours.

Opens the window Set Engine Operating
Hours.

Opens the window Set Date and Time, in which
you can set the clock in the device.

The misfire counters of all ignition controller
outputs are reset and restarted. Misfires that
previously occurred at the outputs are no
longer displayed.

All operating errors are acknowledged. This
can only be implemented while the engine is
not running.

The setup for the access control to the MIC4 is
described in a separate section. Please read
the section Access Control for MIC4 on

page 84.

Opens the window Temperature Extremes in
which the minimum and maximum
temperatures of the controller and output
boards are displayed.

Opens the window Select Language in which
you can change the interface language of the
MICT.

Opens the window Online Update Settings.
Refer to the section Online Update Settings on
page79.

Opens the window Database Settings in which

various databases can be assigned as source
for the MICT.

Opens the window Select Temperature Scale,
in which you can change the unit for the
temperatures shown in the MICT.

Currently not used.
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Symbol Menu Function

Document -» Schedule Curve Opens the window Schedule. Please refer to
the chapter Schedule Curve on page 152.
Tools - Coils Opens a database with information on
MOTORTECH ignition coils.
Help -»> Help Opens the online help function.
Help -> About MICT Opens detailed information on the MICT.

8.6 Online Update Settings

Perform regular online updates

MOTORTECH is constantly expanding its databases. Perform regular online
updates to make optimal use of the opportunities that the MIC4 provides.

The MICT uses data from an engine database and a coil database for the configuration. Such
data can be updated with automatic online updates. The settings for the update can be entered
with the following entry in the menu bar:

Settings -»> Online update settings

M Online Update Settings [t

[7] Enable automatic database updates
[7] use a proxy to access the web
http-Proxy:

Port: 20

[ stowtog | (updste tow | I

You have the following options:

— Enable automatic database updates
Using the check box, you can enable and disable automatic online updates. As the default
setting, the online update is activated and is executed daily (if an internet connection is
established) at first start-up of the MICT.

— Usea proxy to access the web
Use the checkbox to activate settings for internet access via a proxy server, which you can
then set up by entering http-Proxy and Port.
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- Show Log
With this button, you can open a window in which the online updates performed are logged.

- Update Now
With this button, you manually start an online update.

8.7 Self Test

Operational safety!

If you carry out a self-test, it is essential for the gas supply to be switched
off and no more residual gas is left in the combustion chamber. Non-
compliance can result in damage to equipment or injury to persons.

You can run the self test via the MICT to check the order of the wiring and the connection
between the ignition controller outputs and the spark plugs.

Proceed in the MICT as follows:
Device -» Self test

(8 selfTest (=] E e

WARNING

v In using the self test feature it is citical that the fuel to the engine
/ ! has been shut off and the engine purged of any fuel gas. Failure to do
this could result in damage to equipment and nearby personnel!

Status Cydes Cyde Time - All Configured Outputs.
@ Unbimited 9 period 500000 | 2| S
@ Lodked =
1+ Frequency 2,000 (5 Hr
O Actve  Outputs Control
@ Al

> [ascn ) [64] [08)

@ COM3 ID MIC4x1.08 (1.5.1 (00002801])

The following information is provided:

Status
The status displays indicate whether the ignition controller is ready for the self test.

- Locked
The ignition controlleris in a state in which no self test can be done. For example, there is an
error or a configuration is currently being downloaded into the device.
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Active
The self-test is running.

Ready
The ignition controller is ready and the self test can be started.

You have the following options:

Cycles
Determine whether the self-test should run unlimited or be terminated after a defined
number of cycles.

Outputs
Define whether all outputs or only a defined output should be fired during the self test.

Cycle Time - All Configured Outputs

Specify the cycle time either as a period or frequency. The value entered always refers to a
complete cycle. That means that all outputs that are configured are fires once per cycle. If
you only set one output for the self test, this would still only fire once per cycle.

Control
Start or stop a self test using the corresponding buttons.

8.8 Pickup Trace
The traces of the pickup signals support you in checking the behavior of the used pickup and
thus, for example, to detect and analyze irregularities or failures.

Pickup signals are automatically recorded by the ignition controller as soon as they are detected
at the configured inputs. Ten further signals are recorded if an error occurs during operation
(cumulative across all inputs). The recording is then stopped so that the pickup signals just
before the error can be analyzed. The records can be downloaded from the device at any time.

Proceed in the MICT as follows:

Device -» Pickup trace
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Pickup Trace
Example of a pickup trace for a configuration with three pickups:

- Pickup input 1 (cam):
EXAMPLE Single event from the camshaft

- Pickup input 2 (reset):
Single event from the crankshaft
- Pickup 3 (trigger):
Trigger disc of Type N with 160 events from the crankshaft

! MICT Pickup Trace (o] E -

FEile

Pickup Trace

3 1_Iﬂ

=3

g

32 EECEEEREECTEELE O EEE LR EE T E R R LR R R e el

]

oo 1 T 6 1 A O A |
T — 7 T e 1
0 2,000 4.000 6.000 8.000 10.000

Time [ms]

Operation
The following options are available via the menu in the window:

- Open
Opens a previously saved pickup trace.

- Saveas
Saves a pickup trace as a .putrace file.

- Close
Closes the pickup trace.
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There are the following options for the display of the pickup signals:
— Zoom In/Out
Using the mouse scroll wheel you can zoom in and out of the displayed record range.

Alternatively you can also use the plus and minus keys on the keyboard. With the zoom

function, you can e.g. analyze the trigger signal more precisely (pickup input 3 in the
drawing).

M MICT Pickup Trace (o] E -
Eile

Pickup Trace

0O OO AROA A ARTRTA RO

Pickup Input

Yy — [T ——T
4.940 4,960 4.980 5.020 5.040 5.060

—T
5.000

Time [ms]

— Move displayed range
With the right mouse button pressed you can move the displayed range along the time axis.
— Measuring

You can measure distances and the number of events in the displayed range by holding

down the right mouse button to highlight a section. You can find the following information in
the window:

— Position on the time axis
— Time difference (A) between the two selected points

— Number of events counted in the selected period

(M4 MICT Pickup Trace =
Eile
Pickup Trace

RN R i T R
e i
E, L smdims

i A = 1947.019ms
2 A |

& H Input 1 (positive): 11 events, min, period: 159.276 ms, max. period: 213. 162 ms
% ‘t Irwll(poa:we\)lem min. pmnd 79.637 ms, max. period: !.l.‘lﬁ??ms
o [T NIRRT AT I e o e e

- e LA L L

2.000 3.000 4,000 5.000 6.000 7.000 8.000
Time [ms]
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Error Analysis
The pickup traces support you, for example, in analyzing the following errors:

- Configuration of the pickup does not agree with the wiring (e.g. trigger disc configuration,
allocation of the inputs, allocation of the shafts). In this case, you should compare the
values configured with the signals recorded (see Engine - Pickups on page 98).

- One or more pickups have failed.

Pickup Trace

The pickup signals are only recorded on the inputs that are configured in
the MICT. If the configuration of the pickup inputs is not valid (e.g. three
signals from the same shaft), no signals are recorded.

8.9 Access Control for MIC4
If the access control to the MIC4 is activated, access to the following areas is possible with a PIN
only:

- Runtime Adjustment (Reset, timing, energy, secondary voltage estimation calibration and
secondary short calibration)

- Commands (Alarms, error commands, set engine/spark plug operating hours, and self test).
- Configuration (Transferring a configuration to the MIC4)
The access control regulates the accesses to the device via the MICT. For explanations

concerning access control of the MIC4 and the delimitation of the access levels in the MICT, refer
to section Access Control on page 71.

The access control functions can be accessed in the menu bar via:

Device -» Access Control

8.9.1 Enabling/Disabling Access Control

® Enabling/Disabling access control

to 0000. Once the access control has been activated, and the PINs were
changed, these PINs will continue to be used. To activate the access control
again, you will need the PIN for level 3 (Master). It is therefore
recommended to reset all PINs before disabling.

. As a default setting, the access control is not activated, and all PINs are set

If that was not done, or a system must be unlocked for another reason, a
request key can be issued in the MICT. Refer to the section Resetting all
PINs on page 86.
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To enable or disable the access control, proceed as follows:

1. Open the input dialog via Device -» Access Control -» Enable or Disable access control.
2. Enterthe PIN for the level Master (Level 3).
3. Confirm the input with OK.

8.9.2 Login/Logout

If the access control is activated, you are prompted to log in if you want to execute functions that
are allocated to a specific operating level. In addition, you can log in specifically to an operating
level via the menu bar.

To log into a specific operating level, proceed as follows:
1. Open the input dialog via Device-> Access Control -» Login.
2. First select the level you wish to log on to.
Enter the PIN for the desired level.
4. Confirm the input with OK.
> You are now logged into the corresponding level and can execute all functions that are
allocated to this operating level without having to log in again.
After completing the log-in, you can log out again as follows:

Device -» Access Control -> Logout

8.9.3 Changing the PIN

To change the PIN for a specific operating level, proceed as follows:

1. Open theinput dialog via Device -» Access Control -> Change PIN.

2. First select the level for which you wish to change the PIN.
3. Enterthe current PIN for the desired level.

4. Enter the new PIN in the two subsequent fields.

5. Confirm the input with OK.

» The PIN for this operating level has now been changed.
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8.9.4 Resetting all PINs

To reset all PINs, proceed as follows:
1. Open the input dialog via Device -» Access Control -> Reset all PINs.

2. Ifyou are not yet logged into the Master (level 3) level, you will be prompted to log in with
the relevant PIN.

3. Confirm the input with OK.
4. Toresetall PINs, you will be prompted again to enter the PIN for the level Master (Level 3).
5. Confirm the input with OK.

> AllPINs are now reset to the value oooo.
To reset all PINs, you need the PIN for the level Master (level 3). To be able to unlock a system in
case of emergency that was locked in this way, you have the following option:

1. Inthe menu bar, select the entry Device -» Access Control -> Get reset all PINs request key to
open a window with the same name.

2. Send the request key with the serial number to your service contact partner at MOTORTECH
(refer to Customer Service Information on page 166). This key is valid only for the respective
controller and only for a certain amount of time.

> Yourinformation will be verified, and you will receive an authorization key from your
contact partner.

3. From the menu bar, select the entry Device -» Access Control -> Set reset all PINs
authorization key to open a window with this name.

4. Enter the authorization key received in the input field.
5. Confirm the input with OK.

> Ifthe input was correct, all PINs are reset to the default value oooo.

8.10 Working with Configurations

To ensure that the MIC4 correctly interprets incoming data and correctly controls the ignition
system, it requires information about the engine and the ignition system. This information is
stored in the MIC4 as configuration data.

You can use the MICT to perform the following for these configurations:
— Create

- Open

- Edit

— Saveasafile

— Download to the MIC4

- Upload from the MIC4
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8.10.1 Create, Open, Save
3 Click on the symbol to create a new configuration and select the corresponding
T device type. The device type corresponds to the first five digits of the
arrangement number, which you can find on a label on your device.

==

! Select Device Type

Select the device type you want to configure:

4 Ignition Controllers
» MIC3
» MIC3+
4 MIC4
MIC4x1.08 (8 cutputs)
MIC4x2.12 (12 outputs)
MIC4x2.16 (16 outputs)
MIC4x2.16 Z5 (16 outputs)
+ MIC4+
MICS
MICB50
4 Stepper Motor Cards
VariStep
VariStep3

Lo J[ cmat ]

Click on the symbol to open a saved configuration.

=
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M Open Configuration File

. » Computer » O5(C:) » Configuration Files

ok

~To ]l

Organisieren v Neuer Ordner

Name Anderungsdatum

01.09.2015 14:46

__| enginel.micd

|_| engine2.micd

__| engine3.micd

Dateiname: enginel.micd

Typ

MICA-Datei
M
MIC4-Datei

Grolle
14 KB
14KB
14Ke

+  [All Configuration Files (002" +

Click on the symbol to save the configuration currently displayed in the MICT to

a data carrier.
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8.10.2 Upload, Download
= Click the symbol to upload the current configuration from the MIC4 to the MICT.
%g‘ If applicable, the MICT first establishes a connection to the MIC4 connected.

% Click on the symbol to download the configuration set in the MICT to the MIC4.

= jg] This function can only be executed while the ignition is not active. This action
overwrites the existing configuration on the device. If applicable, the MICT first
establishes a connection to the MIC4 connected.

Existing configuration is cleared!

If you download a configuration to a MIC4, the previous configuration is
deleted and the new settings are immediately implemented.

Runtime Adjustments

If you change a configuration stored in the MIC4 via runtime adjustments,
the configuration must be re-uploaded from the device so that the changes
are displayed in the MICT's configuration views.

8.10.3 Compatibility Information
¥ Information l_]

Some optional cenfiguration values could not be uploaded from the device.
Assuming default values.

[show Details..]

If you upload a configuration from the MIC4 to the MICT that does not correspond to the status of
your MICT, or if you open this type of configuration in the MICT, the following situations may
occur:

- Novalues are present in the configuration for certain MICT functions. The MICT assumes the
standard values for these functions.

- The configuration contains function values that are not support by the MICT.
The following situations can occur if you download a configuration from the MICT to a MIC4
whose firmware does not correspond to the status of your MICT:

— Novalues are present in the configuration for certain firmware functions. The firmware
continues to use the preset values for these functions.

- The configuration contains function values that are not support by the firmware.
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If you download a configuration into the MIC4 and are notified of functions that are not
supported by the MICT, you should check the MIC4 settings. Re-upload the configuration from
the MIC4 to the MICT. You can then see which settings are not transmitted to the MICT.

Perform a firmware update, if necessary, and/or update your MICT so that you can use all the
MIC4 functions without restriction.

8.11 Configuration

The window opens after you select the device type for a new configuration or an existing
configuration or have uploaded one from the ignition controller. You can make changes to the
configuration by selecting an entry from the navigation bar. The corresponding configuration
data are then displayed in the configuration section and can be processed. The following
sections will describe the settings and adjustments you can implement in the different areas.

® Indication of invalid entries
An invalid selection or invalid input values are highlighted by pulsating
warning signs on the configuration pages of the MICT. Additional
—_— information is provided in the status bar.
NOTICE P
Example:
4 Miscellaneous
1 Communication Y| RS485
Service Contact RS485 Mode RS485 Settings
9 Modbus Baucrate
Parityrev =1
Stopbits
Modbus Settings
Modbus Address: 1 %
Mode: |rtu n7
5 Stop bits (Default = 1) (invalid due to context) O COMn/a IDn/a ADV.SERVICE n/a Version: 2.7.00000
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8.11.1 Engine — Parameters
B4 unnamed.mic4® (MIC4:2.16) - MICT l=le

File Device 3Settings Document Tools Help

SR E-Pal N LA

Configuration Page |8 anebers
4 Engine | Engne Selection Engine Information
| Parameters Engine Manufacturer Series Type |New Engine Configuration Selected Engine Summary
| Cylinder Names g |
! RIARX E08 Series | E2848LE322 MAN - E2B48LE322
Ignition Qutputs Caterpillar E28 Series E2876E302 s &
! Ignition Coils Clark £2876E312 ey s e
| Pickups Cooper Bessemer E2876LE202 L
# Timing m Ezi 76LE302 ?Bmg Angles
| Analog Inputs Guascor E2876IE302 a0.0
P Ingersoll Rand 180.0
Schedule A i 2700
! G | rr 350.0
eneral Liebherr 450.0
Energy MRN 540.0
4 [)) ScheduleB Hoxdberg &0
Sequence S
General
Superier
Energy Waukesha
| Miscellaneous
4 Inputs/Qutputs
Alarms
| ASOL
1 Inputs
4 Miscellaneous
Communication
| Information

__ MOTORTECH does not assume liabiity for the information in the engine database. Please contact MOTORTECH if discrepandies
i' are found,
L

1f your engine is not available in the kst contact MOTORTECH service please.

@ COM3 IDMICAx2.16(1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2.7.00000

Engine Selection

The MICT holds an engine database with data from various manufacturers and model series.
Select the desired engine manufacturer, series, and type by clicking on the corresponding fields.
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Wiring in firing order is assumed as standard. If straight order wiring is supported for the
selected engine, the Wiring dialog opens and you have the opportunity to adapt the output
configuration.

(M Wiring (2 [t

Please select the type of wiring you are using.

In case of custom wiring please select wiring in firing order and adjust the output configuration
afterwards.

) wired in firing order
© wired in straight order (user defined orientation)

col 1 7| lo] lof|:
3| o] lo]|z
IR ERE
10 o o] 4
uffo] lo]|s
2| |o| |o]ls Col 1
oy 58 [T Tl oyl 14
oyl 712 sl oyl 16
[ change onentation of rad | | change hamess | [ change onientaton of ral |

L )

You can use straight order wiring, if:

— Wiring takes place via a corresponding MOTORTECH wiring harness and a MOTORTECH
wiring rail. The harness is marked with the following information: PLEASE NOTE! The firing
order needs to be configured directly in the ignition controller. The ignition coils on the
wiring rail are marked with Connector Pin 1 to Connector Pin X. The position of coil1 on the
wiring rail is marked in the view Wiring.

—  Wiring of the ignition controller is done corresponding to the instructions in section Straight
Order Wiring of the Ignition Outputs on page 57 (for example with an open wiring harness or
via a junction box).

The configuration of the ignition outputs is automatically adapted corresponding to your
selection. If you want to use a different wiring, these settings must be adapted appropriately.

If the pertinent engine is not available in the database, settings can also be entered by selecting
the corresponding sequence. For this purpose, click on the entry Sequence in the column Engine
Manufacturer and select the firing stroke in the column Series, then the number of cylinders,
and the ignition offset of the engine as needed. After making your selections, the right hand
section Engine Information will display a summary of the parameters selected.

The summarized data are transferred to the subsequent configuration page Ignition Outputs.
The values displayed there can only be changed by users with authorization to access the
Advanced Service level.
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® Engine Database

MOTORTECH does not assume liability for the information in the engine
database. Please contact MOTORTECH if discrepancies are found.

NOTICE

New Engine Configuration

Staff with the authorization for the Advanced Service level additionally has the option for
entering the engine data manually, i.e., without selecting entries from the engine database. For
this purpose, click on the New Engine Configuration button and select the engine type, number
of cycles, and number of cylinders in the dialog box opening up. Additional information can be
entered on the configuration page Ignition Outputs.

[ 84 Diateg [t
Engine Type: [Vengne v
Strokes: [-stroke -]
Number of Cyinders: [18 v

Note: Specify Firing Order and Firing Angles on the Ignition Oulputs Page! |

(o J[ el ]
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8.11.2 Engine — Cylinder Names

[ M unnamed.mica* (MIC4x2.16) - MICT [=]E

Eile Device gSettings Document Jools Help
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| Pickups o3

4 Timing 8

Analog Inputs
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| General
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° 3

| Energy
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i

Inputs
4 Miscellaneous
Communication
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To facilitate the allocation of the cylinders during the configuration of the ignition outputs, you
can individually name each cylinder. The schematic representation of the plan view of the
selected engine supports you in this. Enter the following settings:

— Enable Cylinder Names
Activate the checkbox in order to assign cylinder names. In order to use this function, the
number of cylinders must be defined. Establish the number of cylinders either by using a
configuration from the engine database or by creating a new engine configuration via the
corresponding button. Refer to the section Engine — Parameters on page 9o. If you have
activated the checkbox, the assigned cylinder names must also be assigned to the
corresponding ignition outputs, before the configuration is transferred to the ignition
controller. Otherwise there will be an error message. Refer to the section Engine — Ignition
Outputs on page 94.

— Bank Name
Enter a name for the respective cylinder bank.
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— Cylinder Names
Enter a name for the respective cylinder.
of

- ® §
currently not used

— Show banks in reverse order
currently not used

8.11.3 Engine — Ignition Outputs
B4 unnamed.mic4® (MIC4:2.16) - MICT l=le
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Make adjustments to the following settings as needed:

- Number of Outputs
Select the number of outputs for the respective output board.

—  Column: Cylinder
Select a cylinder. The displayed names are specified on the configuration page Engine —
Cylinder Names.
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—  Column: Output
Select the number of the respective output.

- Column: Angle
Enter the firing angle for each output.

Default Application

If you select from the engine database, the data stored for the selected configuration are
displayed. These data can only be changed by personnel with access to the Advanced Service
level.

New Engine Configuration

If you have created a new engine configuration on the configuration page Engine — Parameters
using the corresponding button, first the number of outputs corresponding to the number of
cylinders are distributed to the output bank A and output bank B. Selecting the number of
outputs enables access to the fields for the configuration of the outputs. We recommend that
you distribute the number of outputs evenly among the output banks and allocate the larger
number to the A output bank if the number is uneven.

By default, the ignition outputs are distributed so that cylinder 1 of the firing order is always
allocated to output bank A with a firing angle of 0°. The further distribution is implemented by
alternating between output bank A and B. The firing angle for each output results from the
addition of the firing interval to the respective previous output.

Operational safety!

Never connect more than one output to each ignition coil, as the output
boards can otherwise be damaged!

The allocation of outputs on the output banks to contacts of the output connector of the device
and the cylinders is determined by the wiring. The user must take the wiring into account during
the configuration; it cannot be checked by the software.

® Interval between two ignitions
The interval between two ignitions on an output bank must be min. 1.7 ms.
During the check, the configured overspeed is used in the calculation.

NOTICE

Rev. 01/2016 95



8 SETTINGS VIA THE MICT

8.11.4 Engine - Ignition Coils
(41 unnamed.micd* (MIC&x2.16) - MICT (== =]
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Ignition Coil Type
Select the ignition coil type from the drop-down list. (Without this selection the configuration
cannot be downloaded to the MIC4.)

Only use measured ignition coils

To operate the MIC4, only ignition coil types measured by MOTORTECH may
be used. Allignition coils used must correspond to the part number
selected in the drop-down list. Different coil types must not be mixed and
also no equivalent or replacement types may be used.

If a coil type used is not in the drop-down list, then the MIC4 is currently not
used.
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Secondary Diagnostics Enabled

The secondary diagnosis can be deactivated and activated for ignition coils that support this
function. If the ignition coil does not support this function, the secondary voltage estimation
calibration and the of the secondary short calibration are not available.

Secondary Voltage Estimation Calibration

A correction value without units can be set for the secondary voltage estimation for every
configured output to increase the accuracy of the secondary voltage estimation for each
individual cylinder. This allows, for instance, different cable lengths on the engine to be
compensated.

The values of the secondary voltage estimation can be changed for each individual cylinder. The
value range depends on the ignition coil. 0.0 is set as the standard value for all cylinders. You
can adjust the secondary voltage estimation while the engine is running in the runtime
adjustments (refer to Runtime Adjustments — Secondary Voltage Estimation Calibration on

page 149).

Secondary Short Detection Calibration

The starting voltage and the secondary short detection sensitivity can be adjusted. You can
adjust the secondary short detection in the runtime adjustments while the engine is running
(refer to Runtime Adjustments — Secondary Short Calibration on page 150).

Secondary Short Enable Voltage
Set the necessary average ignition voltage required to activate the secondary short-circuit
monitoring:

- The secondary short detection is always activated at a value of o kV.

— The secondary short detection is always deactivated at a value of 65.535 kV.

Secondary Short Sensitivity
The permitted value range depends on the set ignition coil.

Set the sensitivity of the short-circuit detection e.g. as follows:
— The sensitivity is high at a value of 0.98.

- The sensitivity is low at a value of 1.02.
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8.11.5 Engine — Pickups
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| Ignition Qutputs
| Ignition Coils
| Pickups
Timing
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Schedule A
| General
Energy
Schedule B
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Energy
| Miscellanecus
Inputs/Outputs
Alarms
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Pidup Setup Information

3PU (N events (passive) and 1 reset event (passive) from crankshaft and 1 event (active high) from
camshaft)

Input 1 (Camy. trigger disc type SINGLE EVENT and active high pick up on camshaft
Input 2 (Resath trigger disc type SINGLE EVENT and passive pick up on aankshaft
Input 3 (THigger): trigger disc type N with 160 events and passive pick up on crankshaft

Pickup Setup

Predefined Setup: [3PU =) | User-defined

BmC ~ | [ Adjust

Index/Resat Position: 60.0
Pickup Sensitivity: | medium X

Trigger No. of Triggers: 160

Aux Pickup Supply Voltage

Aux Pickup Supply Voltage: 24.0/%- V

Speed Settings
Ignition Release:
Security Speed:
Nominal Speed:
Overspeed:
Max. Power-On Speed:

40
250
1500
1800

6000

Q COM3 IDMIC4x2.16(1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2.7.00000
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Active Pickups

Check when using active pickups that the auxiliary supply voltage is
configured for your application.
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Pickup Setup Information
The settings made in the section Pickup Setup were summarized once again in the section
Pickup Setup Information.

Pickup Setup
Enter the following settings in this section:

— Predefined Setup
Select the pickup configuration suitable for your application from the list. The
configurations available for selection depend on the previously entered settings.

— Index/Reset Position
Enter the distance between the first event after the set index/ reset marking and top dead
center. With the button Adjust, you can enter the measured firing angle for a given nominal
value. The system calculates the difference from these values, which is added to or
subtracted from the index/reset position.

— Pickup Sensitivity
Open the pick list and select the desired sensitivity level for the pickup. This setting
overwrites the value of the pre-trigger voltage if the latter was defined in the user-defined
pickup set-up.
— High
The signal processing starts at low engine speeds. This setting can result in increased
susceptibility to failure.

—  Medium
Default setting for MICT. This is a trade-off between start-up speed and sensitivity.

- Low
The signal processing does not start until high engine speeds are reached. This setting
can result in reduced susceptibility to failure.

— Trigger/Cam Teeth Number
Enter the number of events. The input Cam or Trigger is automatically selected by the MICT
and is governed by the selection of the pre-defined pickup settings.

— User-defined
Staff authorized to access the Advanced Service level can, in addition to the standard
settings access, use a manual setup option by clicking on the button User-defined.

[ M Pickup Setup =
Pickup Inputs
Input Type No. of Events Speed Active/Passive  Pre-Trigger [V]
Pickup Input 1 (Cam):  [SINGLE EVENT ) |0 (cusarT -] [actvetich v] 75
Pickup Input 2 (Rese(® |SINGLE EVENT. x| o CRANKSHAFT v | [passive  v] 1.5
S T N | -
o J[ come |
Trigger Disc Type, Default = NONE
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100

Type

Select the type of events that will occur on the respective input for each pickup input.
Type and number of events are defined by the discs or ring gears used. If you decide not
to use a pickup input, select the entry None from the list. You can set the following
types:

N

Disc, which causes a uniformly distributed number (N) of events (per rotation), e.g. a
ring gear with 160 teeth (N=160).

N+1

Disc type N with one additional event, e.g. a disc with 12 teeth and one additional tooth
for the index signal (N=12).

N+1 extended index range

Disc type N with an additional event, e.g. with one disc with 12 teeth and one additional
tooth for the index signal (N=12). The permitted range for the index signal is expanded
to 75 % of the tooth period. An incorrect direction of rotation of the engine cannot be
detected by this setting.

N-1

Disk type N, where one event is missing, e.g. a ring gear with 160 teeth on which one
tooth was removed (N=160). This missing event is used to determine the index signal
N-2

Disk type N, where two consecutive events are missing, e.g. a ring gear with 60 teeth on
which two teeth located next to each other were removed (N=60). This missing event is
used to determine the index signal.

N Magnets, Individual Magnet

You will always use these two types together for a disc with magnets having opposite
polarity. A magnet with a fixed number of magnets (N), all of which are arranged at equal
distances on the disc, has a reverse polarity. Thus, the disc supplies two signals that
can be analyzed by a pickup.

Single Event

Disc that supplies a single event, e.g., a disc with one tooth or one magnet.

Number of Events

Enter the number of events that occur on the pickup if more than one event is expected.
For the types N+1 and N-1, enter the value for N and not the total number of events. With
the type N Magnets, the number of magnets with identical polarity must be entered.
The number of events must lie between 3 and 500. Additionally, it must be ensured that
the sum of the frequencies at the pickup input does not exceed the limit of 10 kHz at the
pre-set overspeed.

Speed
Select whether the respective pickup will pick up the signal off the camshaft or the
crankshaft.
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— Active/Passive
Select the pickup to be used from the pre-defined pick list:
Passive
passive pickup
Active (low)
active pickup with high level as quiescent level
Active (high)
active pickup with low level as quiescent level

— Pre-Trigger
Enter a value between 0.1V and 7.5 V for each pickup to set the pickup sensitivity level.
Signals that fall short of the set voltage will not be analyzed. A low pre-set value
therefore results in a high sensitivity level, a high value results in a low sensitivity level.

Pickup Setup Information

The respective latest setting in the area of the pre-defined or arbitrary
pickup settings is transferred to and displayed under Pickup Setup
Information.

Aux. Pickup Supply Voltage
Enter the supply voltage with which the active pickup is to be operated. A value between 5 and
24 Vis possible.

Speed Settings
Enter the following settings in this section:

— Ignition Release
Enter the release speed for the ignition at which the first ignition is to fire. The value shall
not exceed 1/7 of the nominal speed.

— Security Speed
Enter the security speed (max. half the nominal speed). Below the value entered, the ignition
can be switched on and off as desired. If the ignition is deactivated during operation above
the set speed, the ignition cannot be immediately reactivated. Only when the ignition no
longer reads a speed, i.e., the engine has come to a standstill, can the ignition be
reactivated.

— Nominal Speed
Enter the nominal speed at which your engine is to be operated. With engines that are to be
operated with variable speeds, the max. speed of the operating range must be entered.

— Overspeed
Enter the speed at which the ignition is to be shut off as overspeed protection. With engines
that are to be operated with variable speeds, a speed above the operating range must be
entered.
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- Max. Power-on Speed
Enter the maximum permitted start speed at which the MIC4 starts sending ignition pulses.
Avalue of 6000 rpm is set as the default value: The MIC4 can be activated at the starter
speed and immediately send ignition pulses.
For a value of o rpm the MIC4 can only start sending ignition pulses once it has registered
that the engine is at a standstill.

8.11.6 Timing — Analog Inputs
[ B4 unnamed.micd* (MIC#x2.16) - MICT l=le

Eile Device Zettings Document Tools Help
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| Cylinder Names s (bt 200 ~ion
Ignition Qutputs —
) Igition Catls Fadure Threshold: 3.2  ma
| Pickups Analog Voltage Input
« M Lower Limit: 0.0 Hv
Analog Inputs
4 Schedule A Upper Limit: 5.0 caflid
| General Fadure Threshold: 0.0 Sy
pety Aux Analog Input Supply Voltage
4 Schedule B
General Aux Analog Input Supply Voltage: 24.0% V
Energy
| Miscellaneous
# Inputs/Qutputs
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| ASO1
Inputs
4 Miscellaneous
Communication
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® Aucxiliary supply voltage
Check with the configuration of the analog inputs, that the set auxiliary
supply voltage corresponds to your application.
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Analog Inputs Base Settings
The ignition timing adjustment can be made using two analog input signals, which can be set
within the following limits:

— Analog Current Input: 0-20 mA

— Analog Voltage Input: 0-10 V

Set the Upper Limit and Lower Limit of the signals corresponding to your connected device. Also,
you have the option to enter a Failure Threshold. If the signal does not reach this value, it is
classified by the ignition controller as failure (e.g. wire break). The error value configured in the
schedule was set for the affected input. To reset the error state, a threshold will need to be
exceeded. This threshold value is calculated as follows:

Threshold to reset the error state >= 0.5 x (Lower Limit - Failure Threshold) + Failure Threshold

You set the analog input that will be used and which timing adjustment results from the analog
signal for the two possible schedules. Refer to the section Timing — Schedule A/B — General on
page 104.

Aux. Analog Input Supply Voltage

An auxiliary supply voltage can be configured for the analog inputs. Enter a voltage value
between 5 and 24 V.
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8.11.7 Timing — Schedule A/B - General

Communication

Information

At Lower Limit (0.0V): 0,

At Upper Limit (5.0 V):

Q COM3 IDMIC4x2.16(1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2.7.00000

M unnamed.mic4* (MIC4x2.16) - MICT (=] E )
Eile Device Settings Document Jools Help
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Configuration Page | schedule A General ettings
# Engine | Gl Sthedue Description:  Biogas
Parameters.
Cylinder Names Limits Cylinder Individual Timing Limits
| Ignition Outputs Min/Max Timing Point 13 30.0 e ~| MinfMax Indwvidual Limit 1: 2.0
b 3 )
. ;"mu" bk MinjMax Timing Pont 2: 5.0 e~ MinMax Indvidual Lint 2: 2.0 RET__ ~
ickups
4 Timing Base Timing [¥] Speed Curve
Snaiog Inpats 20.0 [Boc =]  Number of SpeedPonts: (3 =)
4 Schedule A L J L
| General [¥] Patentiometer Function o) ] P
E = (|
31 sy ;“:9; Clodwise: 5.0 |y~ 10 o0
Chedule T
Counter Clodkwise: 5. RET >
General 20 b= ) 2 50 50 REI -
Energy 7] Analog Current Input 3 000 0.0 [rer ]
| Miscellaneous At Lower Limit (4.0mA): 1.0 [aDv - 4 0.0 RET v
# Inputs/Qutputs —
Al At Upper Limit (20.0mA): 7.0 |RET X 5 ET
| ASOL Default: 0.0 6 0.0 RET -
Inputs 7 0.0 ET v
4 Miscellaneous [¥] Analog Voltage Input 5 o

Schedule A General Settings
The MIC4 offers two schedules for implementing the necessary settings for the timing of the
engine. The schedules A and B can be used for dual fuel operation, for example. The system
switches between the schedules via the input Schedule A/B. If only one schedule is configured
the switch is ignored. The configuration options for schedule B are identical to those for set A.

— Enable Schedule

The settings are enabled or disabled by checking/unchecking the box. One schedule must
always be activated.

— Description

Enter a description for the schedule (e.g. natural gas for the setting for this type of gas).

Limits

Enter the limits of the timing point at which the ignition can fire. The timing points of the outputs
will be limited to this range relative to the respective top dead center of the pertinent cylinder.
The global timing can then not be shifted beyond this range by any adjustments.
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Base Timing
Enter the timing specified by the engine manufacturer. This point must be within the limits
entered and is a static portion of the global timing.

Potentiometer Function

The checkbox enables and disables the potentiometer function for manually adjusting the global
timing by the respective stops of the potentiometer set, depending on the direction of rotation. If
the potentiometer is subsequently disabled once again, the system will no longer access the
data during the following data transfer to the device and restart of the engine, and the device
will no longer use this data to calculate the global ignition timing.

Analog Current Input / Analog Voltage Input
The analog inputs can be enabled and disabled by clicking. If you have the choice, you should
prefer the analog current input due to its lower sensitivity to faults.

Enter the values by which the adjustment is to be implemented for the corresponding input
signal. An error value can be entered for the signals if a failure threshold has been defined for
the corresponding input in the window Timing — Analog Inputs. If the signal is below the Failure
Threshold, the timing is offset by the error value. The offset remains until the signal again
exceeds the lower set limit.

Cylinder Individual Timing Limits

Enter the maximum possible cylinder individual offset. This setting limits, among other things,
the adjustment possibility in the window Cylinder Individual Offset. In addition the limits also
apply to the corresponding adjustment signals from all other sources, for example via the field
buses.

Speed Curve

The speed curve can be activated and disabled by mouse click and offsets the timing depending
on the speed. A max. of eight speed points are available. If you select a number of points from
the list, the corresponding number of fields is activated for input.

The first speed point is always set to o RPM. All other timing points are assigned with the value
by which the signal is to be offset when the respective speed is reached. For the last speed
point, the timing of the nominal speed should be entered. Please note that the speed points
must always be entered in ascending order.
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8.11.8 Timing — Schedule A/B - Energy
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Q COM3 IDMIC4x2.16(1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2.7.00000

You can make different energy settings for the start phase and normal operation.

Start Phase

Set the start phase of your engine. To do this you can enter a Speed Limit, a Time Limit or both. If
you enter values for both criteria, both values must also be exceeded, so that the ignition
controller classifies the start phase as ended and sets the values for normal operation. If you
only want to use one criterion, set the other value to o. If you do not want to define any start-up
phase, set both values to o.

Enter values specific to your application for the Spark Duration, the Spark Intensity and the
Maximum Breakdown Voltage. The maximum breakdown voltage corresponds to the maximum
voltage expected during operation.

Normal Operation

If the criteria specified for the start phase are exceeded, the settings for normal operation are
used by the ignition controller. Make the energy settings the same as for the start phase.
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Energy Limit

You can use the field Energy Limit to limit the output energy made available by the ignition
controller. If the set output energy is no longer sufficient to reach the set energy values (spark
duration, spark intensity, max. breakdown voltage), the spark duration is reduced
correspondingly.

Required supply voltage for energy control

Depending on the output configuration and the energy settings, for a
correct energy control, a higher supply voltage than the minimum 10 V DC
sufficient for operation of the device can be necessary. If this is the case,
the required supply voltage is displayed in a notice in the window Timing —
Schedule A/B - Energy.

8.11.9 Timing — Miscellaneous
[ M4 unnamed mica* (MICAx2.16) - MICT =S

Eile Device Settings Document Tools Help
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Parameters Adv: 0.4
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< Timing

Analog Inputs
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4 Inputs/Outputs
Alarms
| ASOL
7 Inputs
4 Miscellaneous
Communication

| Information
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You can specify how fast the changes of the timing should be executed.

- Maximum Firing Angle Change Per Cycle
Specify the maximum degrees per cycle that the ignition timing may be shifted by for both
directions, i.e. between two firings of a cylinder. If the specified ignition timing adjustment
is larger than the given value, it is divided among several cycles.

8.11.10 Inputs/Outputs — Alarms
M4 unnamed.mic4® (MIC4:2.16) - MICT =
Eil

le Device Settings Document Jools Help
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4 Engine | Alarms
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Ignition Qutputs i:“””“: Description:  speed trip
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| Ignition Coils 5: unused Function: [speed > treshold =
| Pickups 6: unused ook [900.0 =
4 Timing 7: unused
Analog Inputs 8: unused Hysteresis: 0.0 RPM
4 Schedule A 9: unused Delay: 0 o
G | 10: unused
e 11: unused Settings
Energy 12: unused -
4 Schedule B 13: unused L] Engine Shutdown
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Log Events.
Energy 16: unused S
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The MIC4 ignition controllers include a total of 16 configurable alarms that can be allocated to
the general purpose output.
— Description
You can enter any desired description for an alarm. The description is used for logging the
alarms that have occurred in the event list in the MICT.
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Function
The alarms can be used depending on the following functions:

— Unused

— Speed above threshold / below threshold

— Engine operating hours above threshold / below threshold

— Spark plug operating hours above threshold / below threshold
— Warning active

— Error active

— Temperature above threshold / below threshold

— Analog voltage input over threshold / under threshold

— Analog current input over threshold / under threshold

— Global ignition timing above the threshold / below the threshold
— Supply voltage above threshold / below threshold

— Min. spark duration above threshold / below threshold

— Misfire rate (primary, single output) over limit

— Misfire rate (primary, all outputs) over limit

— Misfires per second (primary, all outputs) above threshold

— Consecutive misfires (primary, single output) above threshold
— Misfire rate (secondary, individual output) above threshold

— Misfire rate (secondary, all outputs) above threshold

— Misfires per second (secondary, all outputs) above threshold
— Consecutive misfires (secondary, single output) over the limit
Threshold

Input of desired threshold value.

Hysteresis
Input of desired hysteresis value.

Delay

Input of desired delay. The threshold value defined in the alarm must have been exceeded or
not reached for a longer period than the specified time for an alarm to be triggered. If a
corresponding value occurs for a shorter period of time, no alarm is triggered.

Engine Shutdown
If this checkbox is checked, the ignition is switched off as soon as the alarm is triggered.

Permanent — Keep output activated until alarm is acknowledged

If this box is checked, the output remains permanently active until the alarm is
acknowledged. If the box is not checked, the output remains active only for as long as the
alarm is active.
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Log Events

If this box is checked, the event list records when the alarm occurred or when it was

acknowledged.

Outputs

Activate the checkbox GPO1, so that the general purpose output is activated when the alarm

is triggered.
GPO Settings

Configure the general purpose output as normally closed or normally open.

8.11.11 Inputs/Outputs — ASO1 (Auxiliary Synchronization Output)

8! unnamed.mic4* (MIC4x2.16) - MICT

(=@ jotn]

File Device 3Settings Document Tools Help

A T3S A %AW E0

Configuration Page
4 Engine
Parameters
" Cylinder Names
Ignition Qutputs
| Ignition Coils
' Pickups
# Timing
Analog Inputs
4 Schedule A
| General
Energy
4 Schedule B
General
Energy
| Miscellaneous
# Inputs/Qutputs
Alarms
| ASOL
1 Inputs
4 Miscellaneous
Communication

Information

|A501
| . of Points:

Point Nr. Angle [7]

0.0

@ N B M b W N e

Pulse Width [us]
200

@ COM3 IDMICAx2.16(1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2.7.00000

Angle Reference: [ACTUAL ANGLES DEPENDING ON GLOBAL TIMING v |
Mode: [Traiing Rising Edge (defaull) -]

Pont Nr.

Angle [7]

Puise Width [uss]
10

With the auxiliary synchronization output, freely definable impulses depending on the angle of
the crankshaft can be generated. For the output, the user defines whether the angle will be
absolute or based on the global timing. The output can generate between 1 and 16 impulses and
only be assigned to one system at a time. One example of the application of the ASO output for a
detonation controller can be found in section ASO: Auxiliary Synchronization Output on page 69.
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No. of Points

Select the number of impulses from the No. of Points list. Please note that the DetCon
detonation controller devices require a single impulse with 200 ps synchronous with the
first cylinder in the ignition sequence. You can get this setting via the button Configure for
DetConz/20.

Angle Reference

Select from the Angle Reference drop-down list whether the angle shall be based on the
absolute angle of the crankshaft or the actual angle depending on global timing. Then, enter
the trigger angle for each impulse and the length of the impulse in ps.

Mode
Select the mode for the ASO signal.
In the default setting Trailing Rising Edge (default), the signal is low-active.

Level
4
t1 t2 |5}
High — —
. ) r s J} ry
Low >

In the setting Trailing Falling Edge (inverted), the signal is high-active.

Level
Fy
t1 tz 3
High t ! =2
Yy + +
Low >

*) active edge marks the configured engine rotation angle

Maximum impulse duration

Please note that the duration of the impulse can be entered as max. 300 ps.
Input of higher values will not be accepted by the system.
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8.11.12 Inputs/Outputs — Inputs
(84 unnamed.micd* (MIC£:2.16) - MICT l=lE )

Eile Device Settings Document Jools Help

AT HS 40 %N EO

Configuration Page Input Settings
# Engine | GPISettngs
Parameters GPI1: [CAN reset (15 puise), device reset (5 5 puise) -

Cylinder Names
| Ignition Qutputs

| Ignition Coils
! Pickups
4 Timing
Analog Inputs
4 Schedule A
| General
Energy

a Schedule B
General
Energy
| Miscellanecus
# Inputs/Qutputs
Alarms
ASOL
| Inputs
4 Miscellaneous
Communication

Information

Q COM3 IDMIC4x2.16(1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2.7.00000

Various functions can be selected for the general purpose input GPl1:

- Disabled
The input GPl1 will not be used.

- CANreset (1 s pulse), device reset (5 s pulse)
This feature allows (e. g. a master control) to trigger a CAN reset and/or a device reset
externally using a high impulse. A high impulse of 1second leads to a reset of the CAN driver
and a high impulse of 5seconds leads to a device reset.

- Warning acknowledge (< 3 s high), error and alarm acknowledge (> 3 s high), device reset (>
15 s high)
This feature allows (e. g. a master control) warnings, errors, and alarms to be confirmed
and/or device reset to be triggered externally using a high impulse. If the high impulse is
shorter than 3 seconds, all warnings will be confirmed. If the high impulse is longer than 3
seconds, all errors and alarms will be confirmed. If the high level lasts for more than 15
seconds, this triggers a device reset.
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8.11.13 Miscellaneous — Communication

+ ) Schedule B
General
Energy
| Miscellaneous
4 Inputs/Outputs
Alarms
1 ASO1L
| Inputs
4 Miscellaneous
| Communication

Information

M ynnamed.micd® (MIC4x2.16) - MICT [=]E
Eile Device gSettings Document Jools Help
= 5| g & - = T -
SITE-PAl B BTN ] [Ele
Configuration Page [Semamikaten
4 Engine | [can
Parameters can c Satti
Cylinder Names
) ALL-IN-ONE (31939) CANopen Node ID: 30 3
Ignition Outputs
| Pickups i cAooen
4 Timing
Anzlog Inputs RS435
4 ] Schedule A RS5485 Mode RS5485 Settings
] Guneral B
] Energy

Modbus Settings

Q COM3 ID MICA4x2.16 (1.5.1 [0000c801]) ADV. SERVICE Full Access Version: 2.7.00000

CAN

Clicking on the CAN checkbox enables or disables the CAN interface on the device.

— ALL-IN-ONE (J21939)/)1939/CANopen
Select the desired protocol, depending on whether you want to set the communication for
the ALL-IN-ONE or for another device. For example, for a connection to the PowerViews,

select CANopen.
— ]1939 Settings

The J1939 source address can be assigned between o and 253. Note that IDs cannot be
assigned more than once.

— CANopen Settings

The CANopen node ID can be assigned between 1 and 127. Note that IDs cannot be assigned

more than once.
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- Baudrate
Select the desired data transfer rate from the list. The baud rate can be defined between
50 kBit/s and 1 MBit/s, the recommended value being 250 kBit/s.

RS485

Clicking on the field RS485 enables or disables the Modbus interface on the device.

— Baudrate
Select the desired data transfer rate from the list. The Modbus baud rate can be defined
between 9600 and 115200 bit/s, the recommended value being 19200 bit/s.

- Parity
Define if a parity bit is used and if the parity is to be even or odd.

- Stopbits
Determine if one or two stop bits are to be sent. Two stop bits can only be sent if no parity
has been selected.

- Modbus Address
The Modbus address can be assigned between 1 and 247. Note that IDs cannot be assigned
more than once.

-  Mode
Define if the data are transferred in the ASCII or RTU mode.

Setting the transfer rate

Please note that all devices connected with a bus must be set to the same
transfer rate.

Information on protocols

Please contact your MOTORTECH contact partner if you require more
information on the CANopen, J1939 and Modbus protocols.

114 Rev. 01/2016



MOTORTECH

8.11.14 Miscellaneous — Information
This configuration page can be viewed by all users, but changes can only be made with
authorization for the Service access level.

(8 unnamed.micé* (MIC4x2.16) - MICT (= [
Eile Device Settings Document Tools Help
SITEE-Pal B Bt =15

‘ Information
Site and Module

Configuration Page
4 Engine |
| Parameters Site Description:
7 Cylinder Names Site Location:
Ignition Outputs
| Ignition Coils Module Description:
7 Pickups Engine Type Descripton:
< Timing
Analog Inputs Service Contact
4 ] Schedule A Contact Infarmation (..e. company, name, phone, &-mail):
7 General '
Energy
4 [ 3] ScheduleB
| General
| Energy
7 Miscellaneous
4 Inputs/Outputs
Alarms
| ASOL
7 Inputs
4 Miscellaneous
Communication

| Information

@ COM3 IDMICAx2.16 (151 [0000cE01]) ADV.SERVICE Full Access Version: 2.7.00000

Site and Module
In this section, enter information on the system and the module for which the configuration will
be used.

Service Contact

In this section, individual contact data can be saved that can be called up and displayed via
MICT.
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8.12 Runtime Data
Click on the symbol to open the window Runtime Data. The following sections will give
you an overview of the data you can view on the individual tabs.

You can print and record the runtime data. For this purpose, the following functions are at your
disposalin the toolbar in the window:

Symbol Function

Prints the runtime data.

=y
)9
/;:5 Prints the runtime data to a PDF file.
=7 Opens the print preview.
<
N Starts the runtime data trace.
(¥
N Stops the runtime data trace.
Ll
_5\1: Acknowledges the operating errors. If an operating error is acknowledged, all
o

alarms are also simultaneously acknowledged. The symbol is grayed out if no
acknowledged error is present.

Displaying older runtime data files

Due to modifications on the message lists, recorded errors, warnings and
alarms of older runtime data files can be missing when they are displayed
in the current version of the MICT.

Runtime data files that were recorded under the following conditions are
affected:

— MICT version prior to 1.31.x and

— Firmware version 0.14.4 or older
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8.12.1 Runtime Data — Overview

M! MICT - Runtime Data = |8

- B-=p:- JOROE)

Overview | Timing | Igniton | BankA | States | Messagelog | | | information |

Speed Device State

@ Idie @ Configuration
@ Synchronizing @ Self-Test

@ Firing Active

@ Firing Locked

@ Wait for Stop @ Start Phase

@ Warning @ Alarm

Q@ Eror

Control

@ Firing Enabled
@ Schedule A
@ Schedule B
Q@ cPi

Qutput
Q@ GrO1

Failure
@ Analog Current Input (D Analog Voltage Input

@ Ignition Qutput

Timing Misfire Rate
Global Timing Point [l BTOC Primary Secondary
—— single cutpt [ > [ =
perating Hours
9 :
soark Pucs [N Arovps IEEER IR
engine | IERN - .

@ COM3 D MIC4x1.08 (151 (00003801)) Lifetime: 135:43:08.675

In this screen, you can find the following information:
- Speed Indicator (analog)

— Red Pointer
Displays the current registered speed

— Yellow Pointer
Displays the maximum registered speed since last starting the engine

— Green Pointer
Display of set overspeed
- Speed Indicator (digital)
Digitally displays the current speed

— Global Timing Point
Digital indication of the current global timing
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— Operating Hours

— Spark Plugs

Indicates the current operating hours of the spark plugs
— Engine

Indication of current operating hours of the engine

— Device State
The status of the device is shown by the following status displays:

Idle The ignition is ready and waiting for pickup activity.
Synchronizing Pickup signals are being received and analyzed.

Firing Active The ignition is active.

Firing Locked Pickup signals are being received and are valid, ignition is

not released.

Wait for Stop Pickup signals are being received, the ignition fired above
the security speed, and the ignition release was retracted.
The engine must now come to a standstill.

Configuration The device is being configured.

Self Test The self-test is running (refer to Self Test on page 80).

Start Phase The engine is in the configured start phase (refer to Timing —
Schedule A/B - Energy on page 106).

Warning A warning has occurred (refer to Warnings on page 134).

Error An error has occurred (refer to Error on page 136).

Alarm A configured alarm has occurred (refer to Alarms on
page 135).

- Control

— Firing Enabled
The green status display signals that the firing is active.

— Schedule A/B
The green status display shows which parameter settings are currently used.

- GPI1
The status display shows the status of the input signal.
—  Output

- GPO1
The general purpose output is switched on with the green status display.
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— Failure

— Analog Current Input
The red status display signals that the set failure threshold for the input has been
reached. If the lower limit of the signal is reached again, the status display is again
gray.

— Analog Voltage Input
The red status display signals that the set failure threshold for the input has been
reached. If the lower limit of the signal is reached again, the status display is again
gray.

— Ignition Output
The red status display signals a current misfire on at least one output. With a yellow
status display at least one misfire has occurred at one output since the last reset of the
counter.

— Misfire Rate
The misfire rate is displayed for the primary side and secondary side. The misfire rate on the
secondary side is only displayed if the secondary side diagnosis is activated (refer to Engine
— Ignition Coils on page 96).
— Single Output
Displays the misfire rate of the output for which the most misfires were registered
during the last 32 cycles.

— All Outputs
Displays the misfire rate for all the ignition outputs for the past 32 cycles.

— The number of misfires per second are calculated by the MIC4 as follows:
2-stroke engine: Number of currently misfiring outputs x RPM / 60
4-stroke engine: Number of currently misfiring outputs x RPM / 60 / 2
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8.12.2 Runtime Data — Timing

M MICT - Runtime Data =&

FEH =B

[ Overview | Tming | fontion | BankA | States | Messagelog | D ics | Temperatures

Global Timing Paoint Calculation

Base Timing + -BTDC
Potentiometer Timing + - ADV - % ——
(RE B e s O B e I |

] 20 40 60 80 100

_mA_—

s )
q

Analog Current Input Timing

Analog Voltage Input Timing + - ADV _ v -

+
o
m
—

Speed Curve Correction
Timing Correction

Global Timing Point [ 570¢

Indradual Timing

*
o
m
—

minimum [ EIH 8T0¢
Maximum - BTDC
Average - BTDC

@ COM3 ID MIC4x1.08 (1.5.1 (0000a801)) Lifetime: 135:44:30.676

In this view, the system displays all values and settings in the left hand section that influence
the timing. In the right hand section, values are additionally displayed and shown as a bar chart
that are measured at the three inputs (potentiometer, analog current and voltage input) and thus
cause the changes to the timing shown. The value for the speed curve results from the curve
progression set in the configuration. Refer to the section Timing — Schedule A/B — General on
page 104. The timing correction can be implemented for the runtime. Please refer to the section
Runtime Adjustments — Timing on page 147.

In the lower range, the maximum, minimum and average of the cylinder individual offsets are
also displayed.
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8.12.3 Runtime Data — Ignition

(8 MICT - Runtime Data = |8
A .G
Overview | Tming | lgnton | BankA | States | Messagelog | I | information |
Output Cylinder Semfﬂ‘:ﬂ’(}z‘;fm o B
M A e e @
S N e e Y
s ‘Bl — ¢ oo 19
“« Bl — o o @
m (M1 27 71 v . ®
o 'HE — - o o o 19
s /Il 0 @
A e I P I
Coll Data Version: 1
@ COM3 1D MIC4x1.08 (1.5.1 (0000a801)) Lifetime: 135:45:43.676

The following information is provided:

— Column: Output
Designation of the output

— Column: Cylinder
If cylinder names are assigned, these are displayed.

— Column: Estimated Secondary Voltage [kV]
Secondary voltage determined by the ignition controller of the respective output.
The secondary voltage is used to determine deviations between the individual outputs.
These indicate a possible problem at this output (e. g. problems in the area of the spark plug
or the cylinder).
If you have set the ignition coils (refer to Engine — Ignition Coils on page 96) for which a
secondary voltage estimate does not seem possible "---" appears.
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- Column: Misfire
The red status display signals a current misfire at the respective output. With a yellow status
display at least one misfire has occurred at the respective output since the last reset of the
counter.

The coil data version configured in the MICy4 is displayed under the ignition runtime data.

8.12.4 Runtime Data — Bank A and B

( ! MICT - Runtime Data =8
T—— s
S’ gﬁ 3.'51 e B g
Overview | Tming | Igniton | BankA | States | Messagelog | D | Temperatures | ]
Misfire

3 Angle Min. Spark ~ Energy <
Output Cylinder |kt Duration [ps] Output [ml] Primary Secondary

open short Rate [%] open short Rate [%]
~ «HHE-~Eil El o ol o o
2 s~ Hil B o ol o o
~ SHE-~ Nl B o ol o o
s o I BN o o HH o o HE
a5 - B o ol o ©
A8 ‘o B o ol o 0
~ -~ EE o ol o ol
A o N Bl 0o ol o o

Show Firing Angles: @ Relative () Absolute

@ COM3 ID MIC4.08 (1.5.1 [0000a801]) Lifetime: 138:25:12.413

The following information is provided:

—  Column: Output
Designation of the output

- Column: Cylinder
If cylinder names are assigned, these are displayed.

— Column: Angle
Current output firing angle
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—  Column: Min. Spark Duration
Minimum spark duration of the outputs

- Column: Energy Output
Current energy release of the output

— Columns: Misfire
Status display for the different types of misfires (primary, secondary, open, short circuit). In
case of misfire, the respective status display turns red, otherwise it is gray. With a yellow
status display misfires have occurred since the last reset of the counter.
If you hold the pointer over the status display, an overview of the misfire counter of the
respective output is displayed for all types of misfires. A maximum up to 255 is counted per
type of misfire. The counter manually resets using the menu item Device-» Send command -»
Reset misfire counters. When starting the engine and starting the self test the counters are
automatically reset.

You have the following options:

— Relative/Absolute
Select via the option, whether the firing angle should be displayed absolute or relative.

Rev. 01/2016 123



8 SETTINGS VIA THE MICT

8.12.5 Runtime Data - States

M! MICT - Runtime Data = | &

FER =

[ Overview | Tming | fontion | Banka | States | Messagelog | D ics | Temperatures

Operating Hours  Time Status Message
135:51:17.286 2015-12-09 13:39:48 PUL: Missing index.
135:51:17.286 2015-12-09 13:3%:48 PU2: Operational error.
135:51:17.286 2015-12-09 13:3%:48 PU2: Missing index.

@ COM3 1D MIC4x1.08 (1.5.1 [00002801]) Lifetime: 135:51:51.679

Status messages are listed in the view States.

The following information is provided:

124

Operating Hours

Operating hours counter reading at the time of message
Time

Date and time of the message (see following information box)

Status Message
Message text
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Date and time of ignition controller

The date and time can be individually configured for each ignition controller
and saved in the device. The device does not adjust automatically for
daylight savings time. Hence, deviations may occur between the device
time and the time on the computer used to access the device.

NOTICE

Correspondingly, the times indicated for the states, messages, and in the
log reflect the time of the ignition controller. The current time of the ignition
controller is shown in the view Runtime Data — Information. You can adjust
the time of the ignition controller by entering the desired time in the menu
via Device -» Set date and time.

Status messages are displayed in black if they are current. If a status is reset, the status
message is displayed gray for 10 seconds before it is deleted from the list.

The following status messages can be displayed:

Status message Description

Alarm shutdown caused by alarm  The engine was shut down by an alarm, as the configured

number. limit was exceeded or not reached. You can view the
alarm number in the configuration (see Inputs/Outputs —
Alarms on page 108).

Analog current input failure Failure threshold set for analog current input was
(current: x mA, failure threshold: undershot (see Timing — Analog Inputs on page 102).

y mA, failure reset threshold: The following values were obtained: Current: x mA, failure
zmA). threshold: y mA, threshold for failure reset: z mA.

Analog voltage input failure Failure threshold set for analog voltage input was
(voltage: x V, failure threshold: undershot (see Timing — Analog Inputs on page 102).

y V, failure reset threshold: z V). The following values were obtained: Voltage: x V, failure

threshold: y V, threshold for failure reset: z V.

Aux analog input supply voltage Error in auxiliary supply voltage of analog inputs (see

failure (voltage: u V, desired Timing — Analog Inputs on page 102). The following
voltage: v V, failure threshold: x V, values were obtained: Voltage: u V, expected voltage: vV,
failure reset threshold: y V). failure threshold: x V, threshold for failure reset: y V

Aux pickup supply voltage failure  Error in auxiliary supply voltage of pickup (see Engine —
(voltage: u V, desired voltage: vV, Pickups on page 98). The following values were obtained:
failure threshold: x V, failure reset Voltage: u V, expected voltage: v V, failure threshold: x V,
threshold: y V). threshold for failure reset: y V

Configuration data checksum The checksum of the configuration data is faulty. The

error. Using default configuration. default configuration is used. This message may appear
during an upgrade/downgrade. Check your configuration
data and the MICT version being used. Then download the
configuration to the device once again.
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Status message Description

Configuration invalid. Using The configuration is invalid. The previous configuration is

previous configuration. used. This message may appear during an
upgrade/downgrade. Check your configuration data and
the MICT version being used. Then download the
configuration to the device once again.

Current sensor of output bank The current sensor of output bank name failed. Restart

name failed. the ignition controller. If the error occurs again after
restarting the device, please contact MOTORTECH.

Device started after supply The device was started after a failure of the supply

voltage failure. voltage. Please check the power supply of the device
where applicable.

General error number. General error number. Restart the ignition controller. If
the error occurs again after restarting the device, please
contact MOTORTECH.

Global timing x° crankshaft limited The global timing (x° crankshaft) is located outside the

to range y° crankshaft .. z° configured limits (y° crankshaft .. z° crankshaft; see

crankshaft. Timing — Schedule A/B — General on page 104).

Incompatible coil parameters The device received incompatible coil parameters. The

received, secondary voltage secondary voltage diagnostics have been disabled. This

diagnostics disabled. message may appear during an upgrade/downgrade.

Check your configuration data and the MICT version being
used. Then download the configuration to the device once

again.

Output board identification failed The identification of the output board failed due to a

due to a checksum error. checksum error. Restart the ignition controller. If the error
occurs again after restarting the device, please contact
MOTORTECH.

Output board identification failed The identification of the output board failed due to

due to incompatible hardware. incompatible hardware. Restart the ignition controller. If
the error occurs again after restarting the device, please
contact MOTORTECH.

Output board identification failed The identification of the output board failed due to

due to missing data. missing data. Restart the ignition controller. If the error
occurs again after restarting the device, please contact
MOTORTECH.
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Status message

Output board identification failed
due to unknown error number.

Output board identification failed
due to unknown hardware.

Pickup configuration invalid.

Power failure detected on output
Anumber/Bnumber.

Power output (x W) exceeded error
threshold limit (y W) at a supply
voltage of z V.

Power output (x W) exceeded limit
(y W) at a supply voltage of z V.

Power output (x W) exceeded
permanent limit (y W) at a supply
voltage of z V.

PUnumber: Faulty index.

Rev. 01/2016

Description

The identification of the output board failed due to
unknown error number. Characteristic data of the output
board could not be read, they are defective or do not
match the device. Restart the ignition controller. If the
error occurs again after restarting the device, please
contact MOTORTECH.

The identification of the output board failed due to
unknown hardware. Characteristic data of the output
board could not be read, they are defective or do not
match the device. Restart the ignition controller. If the
error occurs again after restarting the device, please
contact MOTORTECH.

The pickup configuration is invalid. This message may
appear during an upgrade/downgrade. Check your
configuration data and the MICT version being used. Then
download the configuration to the device once again.

Power supply fault in output board at output
Anumber/Bnumber was detected. Restart the ignition
controller. If the error occurs again after restarting the
device, please contact MOTORTECH.

The power output (x W) exceeded failure threshold (y W) at
a supply voltage of z V. Increase the supply voltage and
check the energy settings (see Timing — Schedule A/B -
Energy on page 106).

The power output (x W) exceeded warning threshold limit
(y W) for longer than two minutes at a supply voltage of
z V. Increase the supply voltage and check the energy
settings (see Timing — Schedule A/B — Energy on page
106).

The power output (x W) exceeded warning threshold limit
(y W) for longer than three minutes at a supply voltage of
z V. Increase the supply voltage and check the energy
settings (see Timing — Schedule A/B — Energy on page
106).

The pickup PUnumber has an error in index. Check the
pickups and the corresponding configuration (see Engine
— Pickups on page 98). Furthermore, also pay attention to
the instructions in the section entitled Pickup Input Errors
on page 165.
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Status message

PUnumber: Faulty Signal. Signal
period (x, events counted y) is too

Description

The pickup (PUnumber) is supplying a faulty signal.
Signal period (x, events counted y) is too small compared

small compared to previous signal to previous signal period (2). Check the pickups and the

period (2).

PUnumber: Index mark missing.

PUnumber: Missing index.

PUnumber: Missing Signal. Signal
period (x, events counted y) is too
great compared to previous signal
period (2).

PUnumber: Missing Signal. Signal
timeout occurred (events counted
X).

PUnumber: No index mark found.

PUnumber: No signal.
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corresponding configuration (see Engine — Pickups on
page 98). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 165.

Index mark missing for pickup (PUnumber). Check the
pickups and the corresponding configuration (see Engine
— Pickups on page 98). Furthermore, also pay attention to
the instructions in the section entitled Pickup Input Errors
on page 165.

Index missing for pickup (PUnumber). Check the pickups
and the corresponding configuration (see Engine —
Pickups on page 98). Furthermore, also pay attention to
the instructions in the section entitled Pickup Input Errors
on page 165.

Signal missing for pickup (PUnumber). Signal period (x,
events counted y) is too large compared to previous
signal period (2). Check the pickups and the
corresponding configuration (see Engine - Pickups on
page 98). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 165.

Signal missing for pickup (PUnumber). Timeout occurred
(events counted until timeout x). Check the pickups and
the corresponding configuration (see Engine — Pickups on
page 98). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 165.

Could not find index mark for pickup (PUnumber). Check
the pickups and the corresponding configuration (see
Engine — Pickups on page 98). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 165.

The pickup (PUnumber) is not supplying a signal. Check
the pickups and the corresponding configuration (see
Engine — Pickups on page 98). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 165.
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Status message

PUnumber: Number of events (x)
counted on pickup input

Description

Number of events (x) counted on pickup input (PUnumber)
does not the match the expected value (y). Check the

PUnumber does not the match the pickups and the corresponding configuration (see Engine

expected value (y).

PUnumber: Operational error.

PUnumber: Polarity detection
failed.

PUnumber: Synchronization
problem.

PUnumber: Wrong pickup signal
polarity on pickup input
PUnumber detected. Reversing
polarity internally.

Self test aborted because pickup

signals have been detected on
pickup input PUnumber.

Speed (x RPM) exceeded
overspeed limit (y RPM) at trigger
signal number.

Temperature of device (x °C)
exceeded error threshold limit

v°0.
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— Pickups on page 98). Furthermore, also pay attention to
the instructions in the section entitled Pickup Input Errors
on page 165.

An operational error occurred at pickup (PUnumber).
Check the pickups and the corresponding configuration
(see Engine — Pickups on page 98). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 165.

Polarity detection failed for pickup (PUnumber). Check
the pickups and the corresponding configuration (see
Engine — Pickups on page 98). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 165.

A synchronization error occurred at pickup (PUnumber).
Check the pickups and the corresponding configuration
(see Engine — Pickups on page 98). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 165.

Wrong polarity of pickup (PUnumber) detected at pickup
input PUnumber. Reversing polarity internally. No
additional action required.

Self test aborted because pickup signals have been
detected on pickup input PU number. Self test can only be
carried out when engine is at a standstill (see Self Test on
page 80).

Potential causes:

— Interference coupling on pickup signal
— Engine was started

The speed (x RPM) exceeded overspeed limit (y RPM) at
trigger signal number (see Engine — Pickups on page 98).
The reason for this may also be an interference coupling
on the trigger signal.

The temperature of the device (x °C) exceeded
failure threshold (y °C). Ensure that there is sufficient air
circulation and/or cooling.
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Status messag Description
Temperature of device (x °C) The temperature of the device (x °C) exceeded warning
exceeded limit (y °C). threshold limit (y °C) for more than two minutes. Ensure

that there is sufficient air circulation and/or cooling.

Temperature of device (x °C) The temperature of the device (x °C) exceeded warning
exceeded permanent limit (y °C).  threshold limit (y °C) for more than ten minutes. Ensure
that there is sufficient air circulation and/or cooling.

Temperature sensor failed. The temperature sensor has failed. Restart the ignition
controller. If the error occurs again after restarting the
device, please contact MOTORTECH.

8.12.6 Runtime Data — Message Log

M! MICT - Runtime Data = | &
— — o~
- = ]l f'm) &
SL = SORCIRC
Overview | Tming | Ioniton | Banka | States | Messagelog | D | Temperatures ]
Operating Hours  Time Category Message o

131:20:14.217  2015-12-08 14:33:54 Info Configuration changed.

131:20:14.222  2015-12-08 14:33:54  Alarm Al alarms reset.

131:22:25043  2015-12-08 14:36:05 Info  Configuration changed.

131:22:25.044  2015-12-08 14:36:05  Alarmy Al alarms reset.

131:25:43.046 2015-12-08 23 Info  Configuration changed.

131:25:43.046 2015-12-08 Alarm Al alarms reset.

132:17:56.966 2015-12-08 Info  Configuration changed.

132:17:56971 2015-12-08 Alarm  All alarms reset.

132:18:50.647 2015-12-08 Info  Configuration changed.

132:18:50.652 2015-12-08 Alarmy Al alarms reset.

132:33:08.030 2015-12-08 Info  Device switched off.

132:33:09.206 2015-12-09 Info  Device (firmware 1.0.1.21538) started at a supply voltage of
132:33:09.296 2015-12-09 Infe  J1939 on interface CANL changed state to "Enter”.
132:33:09.557 2015-12-09 Info 11939 on interface CANL changed state to "Start succeeded
132:36:02.503 2015-12-09 Info Device switched off.

132:36:03.768 2015-12-09 10:. Info  Device (firmware 1.0.1.21538) started at a supply voltage of
132:36:03.769 2015-12-09 10:24:32 Info  J1939 on interface CANL changed state to "Enter”.
132:36:04.020 2015-12-09 10:24:33 Info  J1939 on interface CANL changed state to "Start succeeded
132:44:17.876 2015-12-09 103247  Info  Configuration changed.

132:44:17.882 2015-12-09 10:32:47  Alarm Al alarms reset.

132:51:43495 2015-12-09 11:40:13 Info  Self test started.

133:51:50950 2015-12-09 Info  Self test stopped.

135:39:53.387 2015-12-09 Infe  Cenfiguration changed.

135:39:53.392  2015-12-09 Alarm  All alarms reset.

135:41:39.217  2015-12-09 Info  Configuration changed.

135:41:39.224  2015-12-09 Alarm  All alarms reset.

135:46:48.447  2015-12-09 Emor  Cycle signal was missing, so that more trigger were counte
135:46:48.447 2015-12-09 13: Error  Operational error caused by pickup signals. PUL = 0x00000C
135:47:37.688 2015-12-09 13:36:09 Info  Operational error acknowledged.

135:51:17.286 2015-12-09 13:39:48  Error  Cycle signal was missing, so that more trigger were counte|
13551:17.286 2015-12-09 133948  Emor  Operational error caused by pickup signals. PUL = 0:00200

tl i G

[¥] Automatic scroling Admowledge Alarms

@ COM3 1D MIC4x1.08 (1.5.1 [00002801]) Lifetime: 135:52:31.679
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In the view Message Log, information, warnings, errors and alarms are listed.

Information, warnings and errors are specified by the ignition controller, while alarms can be
freely configured using the MICT. Refer to the section Inputs/Outputs — Alarms on page 108.

Errors and appropriately configured alarms shut down the engine.
The following information is provided:

— Operating Hours
Operating hours counter reading at the time of message

- Time
Date and time of the message (see following information box)

— Category
Type of message (information, warning, error, alarm)

— Message
Message text; you can find more information on the message text in the following sections.

You have the following options:

— Automatic scrolling
If this box is checked, the system automatically displays the last list entry until a new event
occurs.

— Acknowledge Alarms
With this button, you can reset triggered alarms if they are no longer active. An alarm can
only be acknowledged if the checkbox Permanent — Keep output activated until alarm is
acknowledged in the alarm configuration is activated.

® Date and time of ignition controller
The date and time can be individually configured for each ignition controller
and saved in the device. The device does not adjust automatically for

daylight savings time. Hence, deviations may occur between the device

NOTICE . ; :
time and the time on the computer used to access the device.

Correspondingly, the times indicated for the states, messages, and in the
log reflect the time of the ignition controller. The current time of the ignition
controller is shown in the view Runtime Data — Information. You can adjust
the time of the ignition controller by entering the desired time in the menu
via Device -» Set date and time.
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Acknowledging an operating error

While the engine is in standstill, there are the following options for
acknowledging operating errors:

— via Device ->» Send command -> Acknowledge operational error in the
MICT

— Restart / Reset

— Hold button PB on the controller longer than three seconds

Acknowledging warnings

You can acknowledge a warning by briefly pressing the pushbutton PB on
the controller.

Displaying older runtime data files

Due to modifications on the message lists, recorded errors, warnings and
alarms of older runtime data files can be missing when they are displayed
in the current version of the MICT.

Runtime data files that were recorded under the following conditions are
affected:

— MICT version prior to 1.31.x and

— Firmware version 0.14.4 or older

8.12.6.1 Information
Information Description

Access control disabled. The access control was disabled (see Access Control for
MIC4 on page 84).

All access control PINs reset. AlL PINs for access control were reset (see Access Control
for MIC4 on page 84).

CAN interface CANnumber entered The CAN interface CAN number has entered Bus off state

bus off state. (see Runtime Data — Diagnostics on page 140).

CAN interface CANnumber left bus  The CAN interface CAN number has left the Bus off state
off state. (see Runtime Data — Diagnostics on page 140).

CAN reset requested by A CAN reset was requested via general purpose input
GPlnumber. GPInumber (see Inputs/Outputs — Inputs on page 112).
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Information

CANopen on interface CANnumber
changed state to "name".

Configuration changed.

Date and time set.

Device (firmware
number.number.number.number)
started at a supply voltage of x V.

Device reset requested by
GPlnumber failed because pickup
signals have been detected.

Device switched off.
Engine operating hours set to x h.

Failed to change PIN of access
control level "number".

Failed to disable access control.
Failed to enable access control.
Failed to reset all access control

PINs.

J1939 on interface CANnumber
changed state to "name".

Rev. 01/2016

Description

The CANopen at interface CANnumber has changed state
to "name" (state of NMT State Machine according to

CiA DS 301).

The Configuration of device was changed (via the MICT or
via fieldbus).

The date and the time have been set.

The device (firmware number.number.number.number)
was started with a supply voltage of x V.

The device reset requested by GPlnumber failed because
pickup signals have been detected (see Inputs/Outputs —
Inputs on page 112).

The device was switched off.
The engine operating hours set to x h.

Failed to change PIN of access control level "number" (see
Access Control for MIC4 on page 84).

The access control could not be disabled (see Access
Control for MIC4 on page 84).

The access control could not be enabled (see Access
Control for MIC4 on page 84).

Failed to reset all PINs for access control (see Access
Control for MIC4 on page 84).

J1939 on interface CANnumber changed state to "name".
Following statuses are possible:

— Enter/Start succeeded
The CAN mode /1939 or ALL-IN-ONE (J1939) was
started.

—  Start failed
Initialization failed.

- Stop
Assignment of the Source Address was unsuccessful.
A different source address needs to be set in the
configuration (see Miscellaneous — Communication
on page 113).

- Leave
Left CAN mode /1939 or ALL-IN-ONE (]1939).
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Information Description

One or more messages are lost
due to exhausted memory pool or
message queue overrun.

Operational error acknowledged.

PIN of access control level
"number" changed.

Self test denied because no
outputs are configured.

Self test started.
Self test stopped.

Spark plug operating hours set to
xh.

Wrong pickup signal polarity on
pickup input PUnumber detected.
Reversing polarity internally.

8.12.6.2 Warnings

One or more messages were lost because there was
insufficient storage space or too many messages were
queued.

Operating errors are acknowledged.

PIN of access control level "number" changed (see Access
Control for MIC4 on page 84).

The self test could not be carried out because no outputs
are configured (see Self Test on page 80).

The self test was started (see Self Test on page 80).
The self test was stopped (see Self Test on page 80).

The spark plug operating hours were set to x h.

Wrong pickup polarity detected at pickup input
PUnumber. Reversing polarity internally.

Contrary to errors, warnings do not result in the engine being shut down.

Warning

Configuration data checksum

error. Using default configuration.

Configuration invalid. Using
previous configuration.

Disable secondary diagnostic due
to output Anumber/Bnumber.

General warning number.
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Description

The checksum of the configuration data is faulty. The
default configuration is used. This message may appear
during an upgrade/downgrade of the firmware. Check
your configuration data and the MICT version being used.
Then download the configuration to the device once
again.

The configuration is invalid. The previous configuration is
used. This message may appear during an
upgrade/downgrade. Check your configuration data and
the MICT version being used. Then download the
configuration to the device once again.

Secondary diagnosis disabled due to output
Anumber/Bnumber shut off. Check the ignition coil and
wiring at the corresponding output.

General warning number. An undefined warning has
occurred. If this occurs repeatedly, please contact
MOTORTECH.
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Warning Description

Incompatible coil parameters The device received incompatible coil parameters. The
received, secondary voltage secondary voltage diagnostics have been disabled. This
diagnostics disabled. message may appear during an upgrade/downgrade.

Check your configuration data and the MICT version being
used. Then download the configuration to the device once
again.

Invalid coil data received. The device received invalid coil parameters. This message
may appear during an upgrade/downgrade. Check your
configuration data and the MICT version being used. Then
download the configuration to the device once again.

Pickup configuration invalid. The pickup configuration is invalid. This message may
appear during an upgrade/downgrade. Check your
configuration data and the MICT version being used. Then
download the configuration to the device once again.

Power output (x W) exceeded limit  The power output (x W) exceeded warning threshold limit

(y W) at a supply voltage of z V. (v W) for longer than two minutes at a supply voltage of
zV.

Speed (x RPM) exceeded Speed (x RPM) exceeded overspeed limit (y RPM).

overspeed limit (y RPM). Previous  Previous speed was z RPM (see Engine — Pickups on page

speed was z RPM. 98). The reason for this may also be an interference
coupling on the trigger signal.

Temperature of device (x °C) The temperature of the device (x °C) exceeded warning

exceeded limit (y °C) threshold limit (y °C) for more than two minutes. Ensure

that there is sufficient air circulation and/or cooling.

8.12.6.3 Alarms
Alarms can be defined in the configuration. When doing so, each alarm is assigned a number
(see Inputs/Outputs — Alarms on page 108).

Alarm Description

Alarm number "description" The alarm number "description" acknowledged.
acknowledged.

Alarm number "description" The alarm number "description" triggered.
triggered.

All alarms reset. All alarms reset.
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8.12.6.4 Error

All system or operating errors cause the engine to be shut down.

Errors

Alarm shutdown caused by alarm
number.

Assertion failed (x).

Critical error x (y).

Current sensor of output bank
name failed.

Cycle signal was missing, so more
trigger signals were counted than
available per cycle.

Device started after supply voltage
failure.

General error number.

General error in pickup pre-
processing on pickup input
PUnumber.

Number of trigger signals
(number) counted does not match
the configured value.
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Description

The engine was shut down by alarm number. This
function was defined in the configuration (see
Inputs/Outputs — Alarms on page 108).

An assertion was not adhered to (x). For example, an
assumption for a value was not fulfilled in the firmware. If
the error occurs again after restarting the device, please
contact MOTORTECH.

Critical error x (y). If the error occurs again after restarting
the device, please contact MOTORTECH.

The current sensor of output bank name failed. Restart
the ignition controller. If the error occurs again after
restarting the device, please contact MOTORTECH.

Cycle signal was missing, so more trigger signals were
counted than available per cycle. Check the pickups and
the corresponding configuration (see Engine — Pickups on
page 98). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 165.

The device started after a failure of the supply voltage.
Please check the power supply of the device where
applicable.

General error number. An undefined error has occurred.
Restart the ignition controller. If the error occurs again
after restarting the device, please contact MOTORTECH.

General error in pickup pre-processing on pickup input
PUnumber. Check the pickups and the corresponding
configuration (see Engine — Pickups on page 98).
Furthermore, also pay attention to the instructions in the
section entitled Pickup Input Errors on page 165.

Number of trigger signals (number) counted does not
match the configured value. Check the pickups and the
corresponding configuration (see Engine — Pickups on
page 98). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 165.
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Errors Description

Operational error caused by Operational error caused by pickup signals. Pickup
pickup signals. PU1=x, PU2 =y, PU1 =x, Pickup PU2 =y, Pickup PU3 =2z.
PU3 =2z.

For information on the numbers shown, please consult
the documentation on the pickup status bits on the
storage device enclosed with the ignition controller. You
can open the file via the menu: Documentation -> More
information.

Check the pickups and the corresponding configuration
(see Engine — Pickups on page 98). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 165.

Output board identification failed ~ The identification of the output board failed due to a

due to a checksum error. checksum error. Restart the ignition controller. If the error
occurs again after restarting the device, please contact
MOTORTECH.

Output board identification failed  The identification of the output board failed due to

due to incompatible hardware. incompatible hardware. Restart the ignition controller. If
the error occurs again after restarting the device, please
contact MOTORTECH.

Output board identification failed  The identification of the output board failed due to

due to missing data. missing data. Restart the ignition controller. If the error
occurs again after restarting the device, please contact
MOTORTECH.

Output board identification failed  The identification of the output board failed due to

due to unknown error number. unknown error number. Characteristic data of the output

board could not be read, they are defective or do not
match the device. Restart the ignition controller. If the
error occurs again after restarting the device, please

contact MOTORTECH.
Output board identification failed  The identification of the output board failed due to
due to unknown hardware. unknown hardware. Characteristic data of the output

board could not be read, they are defective or do not
match the device. Restart the ignition controller. If the
error occurs again after restarting the device, please
contact MOTORTECH.

Power failure detected on output Power supply fault in output board caused by output

Anumber/Bnumber. Anumber/Bnumber was detected. Restart the ignition
controller. If the error occurs again after restarting the
device, please contact MOTORTECH.
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Errors

Power output (x W) exceeded error
threshold limit (y W) at a supply
voltage of z V.

Power output (x W) exceeded
permanent limit (y W) at a supply
voltage of z V.

Self test aborted because pickup
signals have been detected on
pickup input PUnumber.

Speed (x RPM) exceeded
overspeed limit (y RPM) at trigger
signal number.

Supply voltage failure.

Temperature of controller board
(x°C) exceeded limit (y °C).

Temperature of device (x °C)
exceeded error threshold limit
y°O.

Temperature of device (x °C)
exceeded permanent limit (y °C).

Description

The power output (x W) exceeded failure threshold (y W)
at a supply voltage of z V.

The power output (x W) exceeded warning threshold limit
(v W) for longer than three minutes at a supply voltage of
zV.

Self test aborted because pickup signals have been
detected on pickup input PUnumber. Self test can only be
carried out when engine is at a standstill (see Self Test on
page 80).

Potential causes:

— Interference coupling on pickup signal

- Engine was started

The speed (x RPM) exceeded overspeed limit (y RPM) at
trigger signal number (see Engine — Pickups on page 98).
The reason for this may also be an interference coupling
on the trigger signal.

Supply voltage failure. Please check the power supply of
the device where applicable.

The temperature of controller board (x °C) exceeded limit
(v °0). Ensure that there is sufficient air circulation and/or
cooling.

The temperature of device (x °C) exceeded failure
threshold (y °C) . Ensure that there is sufficient air
circulation and/or cooling.

The temperature of device (x °C) exceeded warning
threshold limit (y °C) for more than two minutes. Ensure
that there is sufficient air circulation and/or cooling.

Temperature of output board (x°C) The temperature of output board (x °C) exceeded limit

exceeded limit (y °C).

Temperature sensor of controller
board failed.

Temperature sensor of output
board failed.
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(v °0). Ensure that there is sufficient air circulation and/or
cooling.

The temperature sensor of controller board failed. Restart
the ignition controller. If the error occurs again after
restarting the device, please contact MOTORTECH.

The temperature sensor of output board failed. Restart
the ignition controller. If the error occurs again after
restarting the device, please contact MOTORTECH.
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Errors Description

Trigger period (x, triggers counted  The trigger period (x, triggers counted y) is not in

y) is not in acceptable range acceptable range compared to previous trigger period (2).
compared to previous trigger Check the pickups and the corresponding configuration
period (2). (see Engine - Pickups on page 98). Furthermore, also pay

attention to the instructions in the section entitled Pickup
Input Errors on page 165.

Trigger signal missing. Current The trigger signal is missing. Current trigger period

trigger period (triggers counted x)  (triggers counted x) is out of the specified range

is out of the specified range compared to the previous trigger period. Check the

related to the previous trigger pickups and the corresponding configuration (see Engine

period. - Pickups on page 98). Furthermore, also pay attention to
the instructions in the section entitled Pickup Input Errors
on page 165.
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8.12.7 Runtime Data — Diagnostics

'g MICT - Runtime Data =&
3R JORCINC

[ Overview | Tming | fontion | BankA | States | Messagelog | Diagnostics | Temperatres | Information |
CAN State

@ Error Active @ Emror Passive Q@ Bus Off

Controller Board

Supply Voltage [V]

] ——

7 T T T T T
0 10 20 30 0

Pickup Input 1 Pre-Trigger [V]
e
0 2 4 6 8 10
Pickup Input 2 Pre-Trigger [V]
e e—
e
L 2 4 L1 8 10

Pickup Input 3 Pre-Trigger [V]
e L

i . —
0 2 4 6 8 10

Aux Pickup Supply Voltage [V]
- . AL R L

0 5 10 15 220 25
Aux Anslog Input Supply Voltage [V]
- T 1 rvrr1 v 71 771151
Q 5 10 15 20 25
Output Board
Power Qutput [W] -

@ COM3 1D MIC4x1.08 (1.51 [00002801]) Lifetime: 135:54:54.680

The following information is provided:

— CAN State
The status display indicates the current error handling status of the device for the CAN bus
communication:

— Error Active
The device is in normal status of the bus communication. If an error occurs in the
communication, the device sends an active Error Flag.

— Error Passive
After a defined number of errors in the bus communication, the device changes to the
status Passive Error. If another error occurs, the device sends a passive Error Flag.

—  Bus Off
The device is disconnected from the CAN bus due to error accumulations in the bus
communication.
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— Controller Board

— Supply Voltage
Current voltage supply of the controller board.

—  Pickup Input Pre-Trigger Voltage
Current pre-trigger voltage for the pickup inputs (refer to Engine — Pickups on page 98).
During operation the pre-trigger voltage for passive pickups is increased depending on
the speed, so that the ignition controller is less prone to interferences.

— Aux. Pickup Supply Voltage
Current auxiliary supply voltage of the pickups (refer to Engine — Pickups on page 98)

— Aux. Analog Input Supply Voltage
Current auxiliary supply voltage of the analog inputs (refer to Timing — Analog Inputs on
page 102)
— Output Board

— Power Output
Current output of the output board
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8.12.8 Runtime Data — Temperatures

M MICT - Runtime Data =&

=g (=d = 8 G2
FN e =y
[ overview | Tming [ Ioniton | Banka | States | Messagelog | D ics | Temperatures | Informabon |

Controller Board
Current Temp [*C) - —

50 1] 50 100 150

Min Temp [*C] - -
o S e e |

50 o 0 100 150

Max Temp [°C) - I 4
[ LI B I e e e e |

50 0 50 100 150
Output Board
Cu"eanemp[’C]- I
T T T

50 L] 50 100 150

Min Temp [*C] - L _____ I
(S T e

50 L] 50 100 150

Max Temp [°C] - I
| L S L N

-50 0 50 100 150

@ COM3 1D MIC4x1.08 (1.5.1 [00002801]) Lifetime: 135:58:12.682

In the window you receive an overview of the temperatures of the controller board and the
output board. The maximum and minimum values are reset at each new start of the ignition

controller.
The following information is provided:
- Controller Board

— Current Temp.
Current temperature of the controller board

—  Min. Temp.
Minimum measured temperature of the controller board

— Max. Temp.
Maximum measured temperature of the controller board
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— Output Board

— Current Temp.
Current temperature of the output board

- Min. Temp.
Minimum temperature measured on the output board

— Max. Temp.
Maximum temperature measured on the output board

8.12.9 Runtime Data — Information
(84 MICT - Runtime Data =S

< 3-=P: JOR0OR

Device

Device ID MIC4 4x1.08 (1.5.1 [0000a801])
Arrangement Mumber 421.08.C000-000-AA4

Serial Number 01011134

Bootloader Version 0.26.2.20138

Firmware Version 1.0.1.21538

Operating Hours 135:59:51.592

Controller Board

Serial Mumber CPU0000295IB

Hardware Version 1.4.0.19856

Qutput Board

Serial Number /0000029518

Hardware Version 1.3.0.12975

Clock

Date and Time Wednesday, December 9, 2015 12:40:31 PM UTC

Q@ COM3 IDMIC4 4x1.08 (1.5.1 [0000a801]) Lifetime: 135:59:51.592

In this view, you can find an overview of the device and version data. If problems arise, you can
print the current runtime data and send them to the MOTORTECH Service Department by fax or as
a PDF file by email. For fast support, we will then immediately have all required information.

Rev. 01/2016 143



8 SETTINGS VIA THE MICT

8.13 Log

Click on the symbol to open the window Log. This window is only available to
D users with authorizations starting at the access level Advanced Service.

M MICT - Log =8

V| Automatic scroling Loglevel: [debug v |
Wi nfa Select file |

12/9/15 1:44 FM /src/daca_handler/daca_handler.cpp (1506) Error setting cag 4351

12/9/15 1:44 PM /src/data_handler/data handler.cpp (1502) Tried to set undefined tag 5152
12/9/15 1:44 PM /arc/pickup signal handler/pickup_signal handler.cpp (442) select inputa: 0
12/9/15 PM /src/pickup_signal_handler/pickup_signal_handler.cpp (442) select inputs: 1
12/9/15 1:44 PM /arc/pickup _signal handler/pickup_signal | .cpp (442) select inputs: 2
12/9/15 1:44 PM /src/pickup_signal_handler/pickup_signal handler.cpp (442) select inputs: 1
12/9/15 1:44 M /src/pickup_signal_handler/pickup_signal_handler.cpp (442) select inpucs: 0

S
-

R e
coooo

T

he window Log serves to support error diagnostics by MOTORTECH.

Automatic scrolling
If the function is active, the view panel focuses on the latest message.

Log level
The selection of the log level is specified by MOTORTECH if needed.

Write log to file
This checkbox activates or deactivates, respectively, the saving of the logged data in a
selected file. If the function is disabled, the logged data are merely shown on the display.

Select file
With this button, you can select a file to which you want to save the logged data.

If you are prompted to create a log file in the case of a service request, proceed as follows:

1.

2.

Open the window Log via the toolbar or the menu bar.
Select a path with the Select file button and enter the file name for the log file.

» Ifthe file does not yet exist, it is automatically created with the extension .log.

Activate the checkbox Write log to file.
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4. Select the level specified by MOTORTECH from the list Log level.

5. Leave the window open.

» The log messages are logged both in the window and in the selected file.

Date and time of ignition controller

The date and time can be individually configured for each ignition controller
and saved in the device. The device does not adjust automatically for
daylight savings time. Hence, deviations may occur between the device
time and the time on the computer used to access the device.

Correspondingly, the times indicated for the states, messages, and in the
log reflect the time of the ignition controller. The current time of the ignition
controller is shown in the view Runtime Data — Information. You can adjust
the time of the ignition controller by entering the desired time in the menu
via Device -» Set date and time.

8.14 Runtime Adjustments

NOTICE

Rev. 01/2016

Click on the symbol to open the window Runtime Adjustments. This window is
only available to users with authorizations starting with access level Service.

Runtime adjustments are implemented directly

All runtime adjustments are implemented directly without requiring the
input to be confirmed and are retained even in the case of a MIC4 restart.
Changes that have been saved in the device configuration are only
displayed after re-uploading the device configuration in the MICT's main
window.
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8.14.1 Runtime Adjustments — Reset

B MICT - Runtime Adjustments =B

["Reset | Tming | Eneray | Secondary Voitage Calbration | Secondary Short Calbration |
reset (<cran) [N ~ov
[#o.sa0v | [ € 010w [(> o.arer | [Bosrer |

@ COM3 1D MIC4:2.08 (1.5.1 (0000a801))

The index/reset position can be corrected by 5 °crankshaft (advanced/retarded) while the device
is being operated. The correction is made with the buttons:

-  0.1ADV/RET
in 0.1° increments to advance or retard

- 0.5 ADV/RET
in 0.5° increments to advance or retard
Changes are implemented immediately and stored in the configuration provided in the device.

If the correction range is not sufficient, the reset/index position must be adjusted in the
configuration (refer to Engine — Pickups on page 98).
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8.14.2 Runtime Adjustments — Timing

M MICT - Runtime Adjustments =i

[ Resst | Twng | Energy | Secondary \oltage Calbration | Secondary Short Calbraton |

Tining comecton (<crane] [N rET

clobal Tming Pont [rcrare) [ Aov

[#osn0v | [ € 0.100v] [® ourer | [Bo.srer

@ COM3 1D MIC4x1.08 (1.5.1 [00003801])

The global ignition timing position can be corrected by 50°crankshaft (advanced/retarded) while
the device is being operated. The correction is made with the buttons:

-  0.1ADV/RET

in 0.1° increments to advance or retard
- 0.5 ADV/RET

in 0.5° increments to advance or retard

The limit for the ignition timing set in the schedule (refer to Timing — Schedule A/B — General on
page 104) cannot be exceeded or not reached with the runtime adjustment.

The correction of the global ignition timing is immediately implemented and also remains in
place if the device is restarted. NOTICE: The configuration defined in the device is not changed.
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8.14.3 Runtime Adjustments — Energy
(141 MICT - Runtime Adjustments (o] E [

[ Reset | Tming | Eneroy | Secondary Voltage Calbration | Secondary Short Calbration |
Schedue A

SP—
[Q-mpsj(-lus] I)+lpsl[”+lﬂpsl

spark Intensity (ma] | ERH
[@€-10ma] [ €-1ma | [& +ima] [ +10ma]

Schedule B

spark ouraton (<] | SN
[ &-100s | [ €-10s | [3 41| (B0

sperk Intensty (mA] [
[#€-10ma] [ €-1ma | [&+ima] (3 +10ma]

@ COM3 1D MIC4:2.08 (1.5.1 (0000a801))

The energy settings can be separately adjusted for both schedules. Changes are implemented
immediately and stored in the configuration provided in the device.

Spark Duration
- +/-1ps

lengthen or shorten in microsecond increments
- +/-10ps

lengthen or shorten in 10 ps increments

Spark Intensity
- +/-1mA

increase and decrease in milliampere increments
- +/-10mA

increase or reduce in 10 mA increments
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8.14.4 Runtime Adjustments — Secondary Voltage Estimation Calibration

M1 MICT - Runtime Adjustments (=S
[[Reset [ Tmog [ Energy. | secondry vltoge Cabranon | secondary St Catraton |
All Qutputs:

[ o5 |[ €01 ][ reset |[ D401 |[Bros ]

Output Offset -0.5 -0.1 +0.1 +0.5
a1 <« (< ) [ » )
A2 € (< ) > ][ » ]
a3 Bl < (< (2> ][ » )
a4 N« (< [ ][ » ]
as <« (€ > [ » ]
46 € )¢ )% ][ » )
a7 Bl < (< ][> ][ »]
x W« (< [ ][ » ]

@ COM3 1D MIC4x1.08 (1.5.1 [00003801])

The secondary voltage estimation can be calibrated in this window when using ignition coils that
support this function:

A correction value without units can be set for the secondary voltage estimation for every output
to increase the accuracy of the secondary voltage estimation for each individual cylinder. This
allows, for instance, different cable lengths on the engine to be compensated.

The secondary voltage estimation should be calibrated under full load at a nominal speed. The
adjustment can be made using the relevant global or individual cylinder buttons. The value
range depends on the set ignition coil. 0.0 is set as the standard value for all cylinders.

Changes are implemented immediately and stored in the configuration provided in the device.
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8.14.5 Runtime Adjustments — Secondary Short Calibration
(141 MICT - Runtime Adjustments [E=E

[Reset | Twming | Energy | Secondary Voltage Calbration | Secondary Short Cabbration
Secondary Short Enable Voltage

Secondary Short Enable Voltage (k] [ - Reset
Secondary Short Sensitvity
Secondary Short Sensitity EREEN

[ dpo1 |[ dpoor || dkoocor|[dkoooo]

(=01 ][ =001 | [ = 0001 ] = o00001]

@ COM3 1D MIC4:2.08 (1.5.1 (0000a801))

The starting voltage and sensitivity for the secondary short-circuit detection can be adjusted.
Changes are implemented immediately and stored in the configuration provided in the device.
Secondary Short Enable Voltage [kV]

Set the necessary average ignition voltage required to activate the secondary short-circuit
monitoring:

- The secondary short detection is always activated at a value of o kV.

— The secondary short detection is always deactivated at a value of 65.535 kV.

Secondary Short Sensitivity
The permitted value range depends on the set ignition coil.

Set the sensitivity of the short-circuit detection e.g. as follows:
— The sensitivity is high at a value of 0.98.

- The sensitivity is low at a value of 1.02.
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Adjust the sensitivity of the short-circuit monitoring

If a short-circuit is misdiagnosed at a sensitivity of 1.00, the sensitivity
must be set to 1.02.

EXAMPLE If a short-circuit is not detected at a sensitivity of 1.00, the sensitivity must
be set to 0.98.

8.15 Cylinder Individual Offsets
. Click on the symbol to open the window Cylinder Individual Offsets. This
window is only available to users with authorizations starting with access level

Service.
("848 MICT - Cyfinder Individual Offsets =|E

vt ilady) 0.5 T 0.1 0.1 - 05
a1 I - L&« . ¢ JL» ] % |
% . - e e J > J.» ]
a3 I = L& L € | > L. » |
A3 I = [« J[ € JL & ][ » |

s - € [ < > IL»
# I = L« JL. < JL 3% JL.» )
A7 - RET [ « | [ € J [ b J » |
8 I = L« JC ¢ JC > JL» ]
@ COM3 IDMIC4x1.08 (1.5 [00003801])

The cylinder individual offset can be applied to the position of the timing point while the
controller is being operated. Offset via keys:
- 0.1ADV/RET
in 0.1° increments to advance or retard
- 0.5ADV/RET
in 0.5° increments to advance or retard

The adjustment option of this function is limited by the specified settings in the configuration.
Refer to the section Timing — Schedule A/B — General on page 104.

Immediate execution of the changes

Please note that changes made to the timing point are executed
immediately at the next firing of the corresponding cylinder. The maximum
performed change per cycle is however limited by the corresponding setting
in the configuration. For this read Timing — Miscellaneous on page 107.
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@ Save changes automatically

Please remember that changes to the ignition timing are saved
automatically.

NOTICE

8.16 Schedule Curve
. Click on the symbol to open the window Schedule.

8.16.1 Schedule Curve — Simulation

M MICT - Schedule l=]E ]
] simuation 35.0 BTDC —F T
o on 1
Potentiometer

w0 8 30.0 BTDC
0 \I g 0.00% 2 e R
e | E ]
0 100 25.0 BTDC 4
I
Analog Current Input ;‘ | R H
10 7 {i-v I S
é 20.0 BTDC &
5 Sy 1s.00ma o ]
=) 25
2 = 5 1 ;
gz s s DO I
'E 150 BTOC - o
Analog Veltage Input = | L
4 3 ] \ i
10.0 BTDC -
2 /\I g 700V 4}
.
5.0 BTOC 1

Schedule 1
© Schedule A *) Schedule 8
A 0.0 AToc i
Bl e e

0 500 1.000 1.500 2.000
Speed [RPM]
— MnTimng — MaxTimng — Min Speed Curve Timing — Max Speed Curve Tming — Speed Curve 4 Current speed
@ COM3 ID MIC4x1.08 (1.5.1 [00002801])
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The schedule curve visualizes the configurations of the schedules and simulates the influence of
the inputs via the speed range. With the optional input fields, you can switch between schedule
A and B. Changes made by turning the control buttons or entering the desired values are
displayed simultaneously.

Simulation
The simulation is activated or disabled using the checkbox.

Potentiometer
Simulation of the potentiometer

— Control button for adjustments between o % and 100 %

— Field for manual input of the desired value in %

— Displays the value in °crankshaft by which the timing is offset

Analog Current Input

Simulation of the analog current input

— Control button for adjustments between the configured values (e.g. o mA and 20 mA)
— Field for manual input of the desired value in mA

— Displays the value in °crankshaft by which the timing is offset

Analog Voltage Input

Simulation of the analog voltage input

— Control button for adjustments between the configured values (e.g. o V and 10 V)
— Field for manual input of the desired value in V

— Displays the value in °crankshaft by which the timing is offset

Schedule A/B

Select between Schedule Aand B

Timing Point
Displays the global ignition timing as it changes during the simulation.

While connected to the device, the ignition timing is simulated depending on the actual engine
speed and marked as @ in the diagram.
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8.16.2 Schedule Curve — Runtime Values

If the checkbox Simulation is unchecked, the Schedule curve window switches to the current
runtime data.

[ 84 MICT - Schedule =l s
7] Simulation 35.0 BTOC 7 7
Runtime Values 1
Schedue
Schadue: A i
Potentiometer 30.0 BTDC
I - . o S -

Analog Current Input ]
Enalog Voltage Input 1 \ ol
- -
v ADV M i
I ¥ i -
Speed : 20.0 BTDC
I - g
Timing Point @ 1 -
I Eromc] | i
[ | Wt
\
1 e
10.0 BTDC -t
5.0 BTOC |
0.0 AToC i -
—— | —
0 500 1,000 1.500 2,000
Speed [RPM]
= MinTiming — MaxTiming — Min Speed Curve Timing — Max Speed Curve Timing — Speed Curve 4 Current speed
@ COM3 1D MIC4x1.08 (1.5.1 [00002801])

The following information is provided:

- Schedule
Displays the currently selected schedule.

— Left column: Potentiometer, Analog Current Input, Analog Voltage Input
Displays the new calculated adjustment values for the potentiometer, current and voltage
input.

— Right column: Potentiometer, Analog Current Input, Analog Voltage Input
Display of values supplied by the ignition controller for the potentiometer, current and
voltage input.
- Speed
Display of the current speed
— Timing Point
Displays the current global ignition timing.

154 Rev. 01/2016



8.17 Coils
The MICT has a database with technical information on MOTORTECH ignition coils. Open the
database as follows:

Tools - Coils

You have the option of storing and printing information on the ignition coils present in the
database. For this purpose, the following functions are at your disposal in the toolbar in the
Coils window.

Symbol Function

Stores the information on the selected ignition coil in a format that is
appropriate for configuring the MIC4 via fieldbus.
Prints the selected coil data set.

Prints the selected coil data set as PDF file.

Opens the print preview.

aa@aed

Coils
— Device

Select an ignition controller.
- Coil

Select an ignition coil.

Select the correct ignition controller

The ignition coil data depends on the ignition controller used. Always select
the ignition controller for which you are using the coils in order to obtain
the correct data.
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8.17.1 General

81 MICT - Cols =l ]
File

- gl (-

o 5959

Cois | General | man. Energy Lt Curve |

Device: [MIC4 = | .

Col: [06.50.003 - Name: 06.50.104

06.50.065 Col Type Id: &
06.50.100 Data Version: 1
06.50.102
06.50.104
06.50.105
06.50.108
0650112 L
06.50.113
06.50.145
06.50.146
06.50.147
06.50.148 Secondary diagnostics avalable if max. breakdonn voltage 5 set in range 38 kV to 47 kv, Addibonally it 5
06.50155 reguired that the energy lnvt is set sufficently high according to the min. energy it aurve,
06.50.156 Col Parameters
x;j: Parameter Min. Max.
06.50162 Max. Breakdown Voltage [kv] 19 a7
06.50.300 Spark Intensity [mA] 32 150
06.50.301 Secondary Voltage Estimation Calbration 5 H
93.09.150 Secondary Short Sensitivity 0.98 102

AEannan s

D

etails

The following information is provided:

Name
Coil name

Coil Type ID
Used to clearly identify the ignition coil

Data Version

Shows data version of the ignition coil selected in the database. The data version of the
ignition coil configured in the ignition controller is displayed in the runtime data in the view
Ignition (refer to Runtime Data — Ignition on page 121). The Automatic Online Update should
be activated to ensure that the coil database always has the latest data sets. Additional
information on the online update is provided in the section Online Update Settings on

page 79.

Illustration of the ignition coil

Information on the conditions under which a secondary diagnosis is possible using the
displayed ignition coil.
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Coil Parameters
The following information is provided:

Max. Breakdown Voltage [kV]

Displays the permitted value range for the maximum breakdown voltage in kV. The
maximum breakdown voltage is configured in the view Ignition Timing — Schedule A/B -
Energy (refer to Timing — Schedule A/B — Energy on page 106).

Spark Intensity [mA]

Displays the permitted value range for the spark intensity in mA. The spark intensity is
configured in the view Ignition Timing — Schedule A/B — Energy (refer to Timing — Schedule
A/B — Energy on page 106).

Secondary Voltage Estimation Calibration

Displays the permitted value range for the secondary voltage estimation calibration. The
calibration of the secondary voltage estimation takes place in the view Engine — Ignition
Coils (refer to Engine — Ignition Coils on page 96) and in the runtime adjustments (refer to
Runtime Adjustments — Secondary Voltage Estimation Calibration on page 149).

Secondary Short Sensitivity

Displays the permitted value range for the calibration of the secondary short sensitivity. The
calibration of the secondary short sensitivity takes place in the view Engine — Ignition Coils
(refer to Engine — Ignition Coils on page 96) and in the runtime adjustments (refer to Runtime
Adjustments — Secondary Short Calibration on page 150).
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8.17.2 Min. Energy Limit Curve
("2 wacT - coits =l ]

File

o 59 5954

Cols

| General | M. Energy Limit Curve |

Device: [MIC4 X Min. Energy Limit Curve

Col: [06.50,003 - K | e e e T S

06.50.065 i i
06.50.100
0650102
06.50104
06.50.105
06.50.108
0650112
06.50.113
06.50.145
06.50.146
06.50147
06.50.148
06.50.155
06.50.156
06.50.157
0650158 50

: B e
06.50.162 15 20 25 30 35

40
06.50.300 Max. Breakdown Voltage [kV]
06.50.301

93.00.150 = Min, Energy Limit == Min. /Max. Limit Secondary Diagnostics

AE s nan e

N
vy
=]

N
=3
=3

n

o
=]

=3
=3

Min. Energy Limit [m3J]

45 50

Min. Energy Limit Curve

The curve provides information on the energy in m) necessary to achieve a certain maximum
breakdown voltage in kV. The two vertical bars show the breakdown voltage area, in kV, in which
a secondary diagnosis is possible. The corresponding energy settings can be found in the view
Timing — Schedule A/B - Energy (refer to Timing — Schedule A/B — Energy on page 106).

When printing the coil data set, the curve values are also provided as a list.
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9 OPERATION

9.1 Start-up

Before you start up the MIC4 ignition controller, take note of the following:

— Were the correct engine, ignition sequence, and output configuration selected? If you are
unsure, contact MOTORTECH or the corresponding engine manufacturer.

— Ensure that the firing order of the engine and/or the wiring of the output cable harness are
carried out correctly.

— Is the wiring of all pickups compliant with the drawings given in this operating manual?

- Are the distances of the pickups to trigger discs, reluctor pins, etc. correctly set (see chapter
Determine the Installation Location of the Pickup on page 38)?

— Ensure that the data were transferred flawlessly to the controller.

— Check whether the start/stop input is set to Firing Active, or whether it works according to
the control requirements of the master control.

— Check whether the input contact for parameter settings A/B (Schedule A/B) functions and
ensure that the correct schedule (A or B) was selected for start-up.

— Ensure that no gas is present in the inlet and exhaust systems before you start the engine.
— Ensure that the gas valve is closed.
—  Perform the normal engine start-up process while the gas valve is closed (start only).

— Connect a stroboscope to the first firing cylinder (cylinder #1) and check whether the timing
point set on the ignition controller coincides with the actual timing point on the crankshaft.
If the ignition timing does not coincide exactly, change it (see chapter Runtime Data on
page 116) until the optimal setting is reached. If the ignition does not fire, read the
instructions in section Troubleshooting on page 165.

— Checkall other cylinders for correct ignition. If they are not correct, stop the engine, and
recheck wiring and ignition sequence for correctness.

— Stop the starting process. If no problems occur, start the engine in accordance with the
specifications of the engine manufacturer.

9.2 Shutdown
The ignition controller is shut down by disconnecting it from the power supply.
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9.3 Firmware Update
Using the MOTORTECH Flash Tool, you can update the firmware of the ignition controller. The
program is provided on the storage device (USB flash drive or CD-ROM supplied).

Install MOTORTECH Flash Tool
Install the MOTORTECH Flash Tool as follows:

1. Start the installation:

— Viathe menu:
Start the file Start.exe on the storage device. Start the installation routine for the
MOTORTECH Flash Tool via Software ->» MOTORTECH Flash Tool -> Install MOTORTECH
Flash Tool.

— Directly from the storage device:
Start the installation routine of the MOTORTECH Flash Tool directly. It is located in
subdirectory Installation on the storage device and for example named as follows:
MOTORTECH-Flash-Tool-0.9.00003-setup.exe.

2. |Install the program.
Follow the instructions on the installation process. Note that the license agreement terms
must be accepted before using the MOTORTECH Flash Tool.

3. Ifthe USB driver is not yet installed, also install it via the menu or directly from the storage
device.

— Viathe menu:
Software -> USB Drivers -» Install USB Drivers

— Directly from the storage device:
Start the exe file in subdirectory Drivers (e.g. CDM v2.10.00 WHQL Certified.exe).

» The MOTORTECH Flash Tool is set up. You can now connect your computer to the ignition
controller via the USB interface.

Menu Bar and Toolbar
After launching the MOTORTECH Flash Tool, the following functions are available to you via the
icons on the toolbar and the entries in the menu bar:

Symbol Menu Function

=) File -> Open Opens a firmware file.
File -» Quit Exits the program.
View -» Extended file information ~ Fades in / out additional information of the
view firmware file.
View -» Extended connection Fades in / out additional information and
settings settings of the connection to the device.
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Symbol Menu

2
&

%%

View -> Reload file Reloads the file information of the selected
firmware file.

Device -» Search devices Restarts the search for connected devices.

Device -» Flash device Starts the update process or downgrade
process.

Settings -> Language Opens the window Select Language in

which you can change the interface
language of the program.

Help -»> Help Opens the online help function.

Help -> About MOTORTECH Flash Opens detailed information on the
Tool program.

Start Firmware Update

Rev. 01/2016

Access control for firmware update

If you have activated the access control for the ignition controller, you need
the PIN for the level Master for the firmware update. For more information
read the section Access Control for MIC4 on page 84.

Backup the existing configuration

Your device's configuration may be lost if the firmware update is not
performed properly. Always backup the existing configuration via the MICT
prior to performing an update. For more information read the section
Working with Configurations on page 86.
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To start the firmware update, proceed as follows:
1. Ifan MICT is connected with the ignition controller, disconnect this connection.

2. Start the MOTORTECH Flash Tool via Start -> Programs -» MOTORTECH -» MOTORTECH Flash
Tool -> x.x.x (e.g. 0.9.00003) -» MOTORTECH Flash Tool.

» The MOTORTECH Flash Tool will now start.

» The software automatically checks all ports for connected devices.

3. Inthe Status section under Device, check if your device has been recognized properly.

» If the MOTORTECH Flash Tool does not recognize a device that is connected to your PC
via the USB interface, you can usually still carry out a firmware update. To do so,
observe the instructions in the information windows of the MOTORTECH Flash Tool for
the following steps.

4. Selectin area File using the Select button the desired update file.

5. By reading the displayed file information, ensure that the update file is correct for your
device.

6. Start the update process using the Flash button or using the menu or toolbar.
» Theignition controller is restarted automatically.
> Now, a window opens informing you about the firmware version currently used on your
ignition controller and also about the relevant update version.
7. Confirm with Yes to proceed with the update process.
> Now the update will start.

> If the firmware update was successful, you will see a relevant message.

8. After a successful firmware update, check all configuration data.

Downgrade process

The process for a downgrade is largely the same as the update process. You
will only be informed that a new firmware has been installed on the device.
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Help with connection problems

If a correctly connected device is not found during the automatic search,
this can, for example, be because too many communication interfaces are
assigned and must be checked. In this case, an interface from the drop-
down list Port in the area Connection can be selected and thus specified.

NOTICE

If the desired port is not yet displayed in the list or if the problem should
continue, an adjustment of the time-outs for the connection helps. The
time-out settings are displayed in the main view by the following entry in
the menu bar: View -» Extended connection settings

Enter the following settings:

— Update Request Timeout
Adjustment range: 1000 ms to 10000 ms, standard value: 3000 ms. An
extension of the time-out can be an advantage, especially with
connection problems that occur because the computer has many
assigned ports.

— Time-out for the Start
adjustment range: 1000 ms to 10000 ms, standard value: 3000 ms. A
time-out change can be an advantage, especially with connection
problems that occur because the communication between the computer
and the device has been interrupted.
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10.1 Possible Faults
The MIC4 ignition controllers include several safety functions that can shut down the engine in
case of fault:

— Overspeed protection

- External shut-down contact (Start/Stop)

- Misfire detection (primary)

— Internal failure of the high voltage supply

— Output Error Detection

- Shutdown in the case of a faulty pickup or faulty pickup signals.
- Alarms

- Faulty voltage supply

— External EMI signals

10.2 Causes of Faults

10.2.1 Overspeed
The engine speed has exceeded the set overspeed value.

Potential Causes
- Speed controller does not function properly
- Fuel supply to engine is not optimal.

- Faulty pickup signal

10.2.2 Output Error Detection

An internal failure of the high voltage supply or a defective output switch occurs.

Potential Causes
— Hardware fault on the MIC4

- Defect in the wiring (short circuit or open circuit)

10.2.3 Misfire Detection (Primary)
Misfiring due to an open circuit on the primary side was detected and displayed in the runtime
data.

Potential Causes
- Defect in the output wiring

— Ignition coil defective
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10.2.4 Pickup Input Errors
Faulty input signals from the pickups are detected.

Potential Causes

— Number of teeth on the flywheel does not match the set number.
— Damage to or uneven running of trigger disc

— Interference in the wiring of the pickup.

—  Wiring of the pickup incorrect

— Distance of the pickup incorrect

— Dirt on the pickup

Troubleshooting for possible causes

You will find information on possible causes of a pickup input error in the windows Runtime Data
— States (see Runtime Data — States on page 124) and Runtime Data — Message Log (see Runtime
Data — Message Log on page 130). When analyzing the messages shown there, please note that
the number of the pickup (e.g. PU2) only names the pickup at which the error or problem was
identified. Hence, this does not mean that this particular pickup also caused the problem. For
example, if the pickup PU1 is defect, it is entirely possible that, under certain circumstances, the
problem may only be identified at pickup input PU2.

For information on the numbers shown in the error messages (e.g. PU1=0x00001002), refer to
the documentation on the pickup status bits on the storage device enclosed with the ignition
controller. You can open the file via the menu: Documentation -> More information.

For a more in-depth analysis of the problem, the pickup traces may support you. Refer to the
section Pickup Trace on page 81. Compare the signals recorded there with the pickup settings in
your configuration (see Engine — Pickups on page 98).

10.2.5 Acknowledging Faults
While the engine is shut down, you have the following options for acknowledging operating
errors:

— Use Error Acknowledge in the MICT
— Acknowledgment of the error via CAN bus or RS485
— Bydisconnecting the supply voltage

— Hold button PB on the controller longer than three seconds

10.3 Troubleshooting

10.3.1 Running a Self Test

You can run the self test via the MICT to check the order of the wiring and the connection
between the ignition controller outputs and the spark plugs. For this read section Self Test on
page 8o0.
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Operational safety!

If you carry out a self-test, it is essential for the gas supply to be switched
off and no more residual gas is left in the combustion chamber. Non-
compliance can result in damage to equipment or injury to persons.

10.3.2 Customer Service Information

You can reach our customer service during business hours at the following phone and fax
numbers, or by email:

Phone:  +49514193 990

Fax: +49 514193 99 99
Email: service@motortech.de

10.3.3 Returning Equipment for Repair / Inspection
To return the device for repair and inspection, obtain a return form and return number from
MOTORTECH.

Fill out the return form completely. The completely filled out return form guarantees fast,
uncomplicated processing of your repair order.

Send the device and the return form to one of the two addresses below or to the nearest
MOTORTECH representative:

MOTORTECH GmbH MOTORTECH Americas, LLC
Hogrevestr. 21-23 1400 Dealers Avenue, Suite A
29223 Celle New Orleans, LA 70123
Germany USA

Phone:  +49514193990 Phone:  +1504 3554212
Fax: +49 514193 99 98 Fax: +1 504 355 4217
www.motortech.de www.motortechamericas.com
motortech@motortech.de info@motortechamericas.com

10.3.4 Instructions for Packaging the Equipment
For return shipment, equipment should be packaged as follows:

— Use packaging material that does not damage the equipment surfaces.
- Wrap the equipment with sturdy materials and stabilize it inside the packaging.
- Use sturdy adhesive film to seal the packaging.
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11 MAINTENANCE

11.1 Maintenance Instructions
Please follow the following maintenance instructions:

— Do not use caustic liquids or steam cleaners for cleaning the device.
— Clean the passive pickups at regular intervals.
— Check the ignition wires at regular intervals.

— Replace the pickups at regular intervals if operating them under elevated temperature
conditions (> 9o °C / » 194 °F).

— Regularly inspect all wires of the ignition system for damage and replace the wires as
needed.

— Check all plug-in connections for proper condition.
— Service the spark plugs as per the instructions of the spark plug and engine manufacturers.
— Observe the required tightening torques:

— All Mg bolts: 0.8 Nm to 1 Nm (0.6 lb-ft to 0,7 lb-ft)

— PG screw joints: 4.5 Nm to 5 Nm (3.3 Ib-ft to 3.6 lb-ft)

— Service screw: 2.5 Nm to 3 Nm (1.9 lb-ft to 2,2 b-ft)

11.2 Spare Parts and Accessories
For spare parts and accessories for MIC4 ignition systems, please refer to our current product
guide, which is available for download on the Internet at www. motortech.de.
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industrial spark plugs and high tension leads, wiring systems and
gas regulation - from detonation to speed control up to complete gas
engine management. On-site support and special training courses
complete our service.

MOTORTECH GmbH
Hogrevestr. 21-23
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Germany

Phone: +49514193990
Fax: +49 5141 93 99 99
www.motortech.de
motortech@motortech.de

MOTORTECH Americas, LLC
1400 Dealers Avenue, Suite A
New Orleans, LA70123
Headquarter USA

Phone:  +1 504 355 4212
ez Fax:  +1504 3554217
@ Sales Partner www.motortechamericas.com
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